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Glossary

EcoCyc
A Pathway/Genome Database for E. coli developed jointly by P. Karp, M. Riley, J. Collado-Vides, I. Paulsen, and M. Saier.

GKB Editor
An SRI software system for interactively browsing and editing KBs that are managed by the Ocelot frame knowledge representation system. For information on the GKB Editor, see http:// www.ai.sri.com/~gkb/user-man.html.

KB
See ‘knowledge base’.

KB developer
A user who modifies a Pathway/Genome Database, as opposed to users who view, but do not update, information in a PGDB.

knowledge base (KB)
A collection of frames and their associated slots, values, facets, and annotations. KBs can be saved per​manently in Oracle databases and in disk files. This document uses the terms ‘knowledge base’ and ‘database’ (DB) interchangeably. A Pathway/Genome Database is a type of knowledge base.

Lisp listener
A program that accepts statements written in the Lisp programming language, evaluates those state​ments, and prints the results. Pathway Tools can be invoked in a mode in which a Lisp listener is active, when the user wants to issue Lisp-based queries to PGDBs -- use the “-lisp” switch when starting Path​way Tools.

listener window
The short horizontal pane toward the bottom of the Pathway Tools main window. Pathway Tools prints messages and sometimes requests information in the listener window. Note that the listener window has nothing to do with a Lisp listener.

MetaCyc
A meta-metabolic database that describes pathways, reactions, and enzymes across a range of different organisms. MetaCyc is a PGDB and is jointly developed by SRI International and the Carnegie Insti​tution of Washington Department of Plant Biology.

PGDB
See ‘PathwayGenome Database’.

PathoLogic Pathway Predictor
A computer program that generates a new PGDB by analyzing the annotated genome of an organism to predict its metabolic pathways. PathoLogic is a component of the Pathway Tools software.

pathway
In the context of the Pathway Tools software, we define a pathway as an interconnected set of biochem​ical reactions, where reactions are connected by sharing common reactants and products. In metabolic pathways, reactants and products are typically low-molecular-weight chemical compounds. In signal​ing pathways, reactants and products are typically proteins.

Pathway/Gexe "pathway/genome database: definition"nome Database (PGDB)
An integrated database that employs the same database schema as does EcoCyc. Pathway/GenomeDa​

tabases are typically created using the PathoLogic Pathway Predictor and represent value-added exten​sions of annotated genomes. Pathway/Genome Databases may be visualized, queried, and updated us​ing SRI’s Pathway Tools software. Each Pathway/Genome Database contains a collection of intercon​nected information describing the biochemical pathways and genome of an organism.

Pathway Tools
The Pathway Tools software system consists of three software components for manipulating Pathway/ Genome Databases: (i) Pathway/Genome Navigator, (ii) PathoLogic Pathway Predictor, and (iii) Edit​ing Tools. The Navigator is used to query, visualize, and analyze the information contained within a PGDB. It does not change this information in any way. To modify this information the user must use Editing Tools, for example, to update information about a particular gene or ORF or to enter informa​tion about a newly discovered pathway. The user may also use Editing Tools to link any piece of infor​mation within a PGDB to information contained within an external Web-based database, for example, a gene-expression relational database. The PathoLogic Pathway Predictor allows the user to computa​tionally predict the pathways of an organism from its annotated genome. The predicted pathways and the description of the genome are then combined to create a new data set. 

reference pathway/genome database
PathoLogic predicts the pathways of an organism by analogy to a reference PGDB.

SMILES
A language for writing chemical structures in terms of character strings [17]. The chemical substructure searcher within Pathway Tools accepts substructures in the SMILES language. See Help ( Smiles for more examples and a description.

subject organism
The organism for which a new PGDB is to be constructed using PathoLogic.

Preface

This document will familiarize you with the Pathway Tools software and the Pathway/Genome Databases (PGDBs) that are available from SRI International. Pathway Tools operates across one or more PGDBs, including the EcoCyc E. coli DB and the MetaCyc DB. Each database describes the biochemical pathways and genomes of a single organism. All PGDBs are managed by an object-oriented database system called ‘Ocelot’.

Pathway Tools contains several component software modules including

• 
Pathway/Genome Navigator, the primary tool by which users visualize, query, and analyze the information contained within a PGDB.
• 
PathoLogic Pathway Predictor, which creates new PGDBs from annotated genomes.

• 
Pathway/Genome Editors, which modify the information contained within PGDBs, such as allowing users to add in-house proprietary data about a pathway or gene of interest. The Edi​tors include a general tool for database browsing and editing, called the GKB Editor.
Pathway Tools is most commonly provided in two different configurations:

• 
BioCyc Configuration. Includes the Pathway/Genome Navigator and one or more PGDBs, such as EcoCyc and MetaCyc. This configuration is available for the Sun workstation run​ning Unix, for the PC running Linux, and for the PC running Windows-98 or higher. The Sun and Linux versions can run as both an X-windows application and as a Web server for the user’s intranet, whereas the PC/Windows version cannot run as a Web server. In this config​uration, PGDBs are physically included inside the binary executable program, and are avail​able for read-only access. In addition, PGDBs that have been created using the full Pathway Tools configuration can be imported into the BioCyc configuration.
• 
Full Pathway Tools Configuration. Includes the Navigator, PathoLogic, and Editors as well as one or more PGDBs. This configuration is available for the Sun workstation running Unix, but not for the PC. The Navigator functionality can run as an X-windows application and as a Web server for the user’s intranet. This configuration allows the creation of new PGDBs, which can be stored either as disk files or in an Oracle database server. Newly cre​ated PGDBs can be updated by users. Use of an Oracle database is recommended if multiple users will be updating a given PGDB.
Volume I of the Pathway Tools User’s Guide describes the Navigator. Volume II describes PathoLogic and the Pathway/Genome Editors.

The PGDBs present in your installation of Pathway Tools will depend on exactly which data sets your organization has ordered. Other PGDBs are available in addition to EcoCyc and MetaCyc. The data con​tent of different PGDBs varies. The EcoCyc DB generally contains more extensive data than do other PGDBs. For example, EcoCyc contains extensive data on operons, promoters, transcription factors, trans​porters, and paralogous gene groups, which other PGDBs tend to lack.

In Volume 1 of this user’s guide

• 
Chapter 1 provides an overview of the pathway bioinformatics tools and databases: what they are, the information they contain, and some of the things they help you to do.
• 
Chapter 2 describes how to invoke Pathway Tools and how to access the Pathway Tools World Wide Web server.

• 
Chapter 3 outlines the Pathway/Genome Navigator. It begins by providing some background information on using the mouse and some examples, to get you started quickly. It then out​lines how to use the Navigator to select one or more databases and, subsequently, query, visualize, and analyze the information contained within these databases.
• 
Chapter 5 outlines what to do if you encounter problems with the functionality of any of the tools or with information contained within any of the provided databases.
Additional Pathway Tools Publica​tions and Web Sites

For more detailed information regarding different aspects of this software, consult the following resources (predominantly, EcoCyc related publications). 

• 
SRI Web site containing a variety of information on the Pathway Tools and its component software systems, including
o
Pathway Tools information site containing samples of Pathway Tools file formats, example Lisp queries to PGDBs, and more, at 
http://bioinformatics.ai.sri.com/ptools/
o
Generic Frame Protocol (the API for Pathway Tools data sets) specification at http:/ /www.ai.sri.com/~gfp/spec/paper/paper.html
• 
GKB Editor User’s Guide at 
http://www.ai.sri.com/~gkb/user-man.html
• 
Scope and contents of the EcoCyc data, discussed in [11]

• 
Ontology (representations) used in the Pathway Tools, discussed in [9,,   ]

• 
Pathway/Genome Navigator, described in [9]

• 
Possible computational uses of the EcoCyc database, discussed in [7]

• 
Ocelot database management system used in Pathway Tools, described in [9]

Many of these publications are available through the World Wide Web at 
http://www.ai.sri.com/pkarp/bio.html#SelPubs
1

Introduction to the Pathway Tools Software

Bioinformatics has been largely sequence centric and focused on building databases to store the large amounts of sequence data being generated by the Human Genome Project and microbial genome initia​tives. In addition, this discipline has involved the development of tools for visualizing, querying, and ana​lyzing sequence data. Most bioinformatics analyses focus largely on identifying genes and predicting the function of encoded gene products. However, increasingly, the focus is moving from considerations of individual genes to consideration of how sets of genes and their corresponding gene products interact with each other and with other molecular players to form the pathways that are the biochemical basis of cellular behavior.

Pathway bioinformatics involves the creation of databases and algorithms for storing and computing with biochemical pathways. Pathway databases typically encode interactions between gene products and other compounds, and the organization of reactions into pathways. In addition, pathway bioinformatics involves the development of tools to query, visualize, and analyze this information. One of the primary advantages of pathway bioinformatics is that it provides descriptions of how the molecular components encoded in a genome interact with each other and with other molecular players to form the biochemical basis of cellular function.

1.1    Databases and Tools

Figure 1-1 provides an overview of the Pathway Tools software. 
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Figure 1-1: The Pathway Tools and related databases

The software components operate on one or more Pathway/Genome Databases (PGDBs) (see the central rectangle). A PGDB is a collection of information that describes some of the biochemical pathways and genes of (typically) a single organism. The pathways might include, for example, signal transduction, transport, and metabolic pathways. The genes may constitute an entire genome, or a subset of genes of interest, for example, those genes that encode a set of pathways of interest.

1.1.1    Databases

The schema of a PGDB describes pathways in terms of five biological entities (see Figure 1-1A):

• 
Union of described pathways (the metabolic overview)

• 
Individual pathways

• 
Reactions that comprise these pathways

• 
Compounds that participate in these reactions

• 
Enzymes (a subset of the gene products) that catalyze these reactions 
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Figure 1-2: Representation of pathways and genomes

Genomes are described in terms of three biological entities (see Figure1-1B): 

• 
Genomic maps of sequenced genetic element(s) 

• 
Their constituent genes

• 
Corresponding gene products (see Figure 1-1 B) 

The gene products that are enzymes provide the primary link between the representation of the genomes and that of the metabolic pathways (see Figure 1-1 C). However, PGDBs typically describe all known or predicted gene products of the corresponding organism, not just those genes whose products are known or predicted to be enzymes—that is, the space of enzymes is a subset of the space of gene products. Incorpo​rated pathways include those of biosynthesis, degradation, energy production, and intermediary metabo​lism, for compounds such as amino acids, carbohydrates, fatty acids, nucleotides, and enzyme cofactors. Different PGDBs vary as to the degree to which they contain transmembrane transport, genetic regulatory, or signal transduction pathways (with the exception of the EcoCyc E. coli database, which contains all of the preceding pathway types).

1.1.2    Pathway Tools

The primary tool via which the user may visualize, query, and analyze the information contained within databases is the Pathway/Genome Navigator. The PathoLogic Pathway Predictor allows you to computa​tionally predict the pathways of an organism from its annotated genome. The predicted pathways and the description of the genome are then combined to create a new PGDB. In addition, with special-purpose, intuitive, interactive editing tools that are not included in the configuration documented here you can mod​ify existing databases, for example, update information about a particular gene or open reading frame (ORF) or enter information about a newly discovered pathway. You can also use these editing tools to link any piece of information within a given database to one or more pieces of information contained within a Web-accessible external database, for example, a gene expression relational database management system.

2

Invoking the Pathway Tools

This chapter provides the information necessary to get you started using the xe "Pathway/Genome Navigator"Pathway Tools. It is assumed that the xe "Pathway: tools"Pathway Tools and xe "Pathway: database"database(s) have been successfully installed on your machine and are ready to run.

The Pathway Tools can be operated in two different modes. In the first mode, a user interacts with the Pathway Tools through the Unix X Window System (X Windows). All of the Pathway Tools software components are available through the X Windows operation mode: the Navigator, Editing Tools, and PathoLogic. In the second mode of operation, the Pathway Tools operate as a web server that can support simultaneous queries from many different users through the network. Only the Navigator operates in web mode.

For technical reasons, when the Pathway Tools are running in web mode, they still require access to the X Windows system, meaning that a proper Unix X Windows environment must be established even though users do not interact with the Pathway Tools through X Windows. Therefore, we begin with a brief over​view of how to define the X Windows environment for use by the Pathway Tools.

2.1
X Windows Basics

xe "X Windows"X Windows is the name of the windowing system on Unix computers. One of the more useful features of X Windows is that it allows a program running on one computer to display its windows on a different com​puter via the network. However, because it is simpler to configure X Windows for the case where the win​dows are displayed on the same computer on which the program is running, we treat these two cases separately.

2.1.1
Program and its Windows on Same Computer

If the name of the Unix computer you are running the Pathway Tools on is “alpha,” before running the Pathway Tools you must execute:

xhost +alpha

setenv DISPLAY alpha:0
2.1.2
Program and its Windows on Different Comput​ers

Let us call the computer on which the program runs the compute host, and call the computer on which the windows will appear the display host. Most commonly, the compute host and the display host are one and the same computer. But they can be different computers, and in fact, the display host need not be a Unix computer, because X Windows compatibility systems exist for the Macintosh and for Microsoft Windows.

Before invoking an X Windows program such as the Pathway Tools, it is important for the user to (a) spec​ify to the compute host the identity of the display host, so that the compute host knows where to display its windows, and (b) to specify to the X Windows security mechanism on the display host that the compute host has the permission to display windows on the display host. These two operations must be performed even when the display host and the compute host are the same computer. Typically these two operations are performed once in a given Unix login session, even if the Pathway Tools are executed multiple times in that login session. If you use SSH (secure-shell software), one or both of these two operations may be per​formed automatically; if not, you’ll have to perform the following steps manually.

To tell the compute host the identity of the display host, execute this Unix command on the compute host (typically you will first telnet or rlogin from the display host to the compute host):

setenv DISPLAY <DisplayHost>:0

To tell the display host that the compute host has permission to display windows on the display host, exe​cute the following Unix command on the display host (the xhost program is often found in directory /usr/openwin/bin/). If the display host is not a Unix system, this command will not be required.

xhost +<ComputeHost>

If the compute host is named “beta” and the display host is named “gamma,” the following commands should be executed on the computers indicated in the comments:

!!!! Execute on host beta, such as by telneting to beta:

setenv DISPLAY gamma:0

!!!! Execute on host gamma:

xhost +beta

Note also that IP addresses may be used in place of host names, such as:

setenv DISPLAY 128.45.54.2:0

One way to verify that the X Windows environment is properly configured is by issuing the command “xterm” on the compute host, which will create an X-terminal window on the display host. If an error mes​sage is printed or if the window does not appear on the correct display, recheck the settings of the DIS​PLAY variable and issue the appropriate xhost command. You can examine the settings of the DISPLAY variable with the command:

printenv DISPLAY
2.2
Invoking the Pathway Tools

xe "Pathway Tools:Invoking"To start the Pathway Tools for X Windows operation on a Unix computer, type:

pathway-tools [args]

The text [args] consists of zero or more command-line arguments as defined under “Command Line Arguments” in section 2.2.1. 

Either the pathway-tools command must be defined in the Unix /usr/local/bin directory, or the directory aic-export/ecocyc/genopath/released/, which contains the Pathway Tools executable file, must be on the user's search path.

For both X Windows and web server operation, a proper X Windows environment must have been estab​lished, as described in the previous section.

xe "Pathway Tools:Exiting"To exit from the Pathway Tools, click on the Exit command in the File menu of the Navigator window.

xe "Pathway Tools:Command line arguments"When you invoke the Pathway Tools for X Windows operation, it will create one large window for the Pathway/Genome Navigator that is divided into several regions, called panes (see Figure 2-1). 
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Figure 2-1: The All Organisms display

Different information is presented in the different panes. The main pane initially contains a listing of loaded databases; in this case, seven microbial databases. The horizontal pane at the bottom will print the names of commands that you select by clicking the mouse in the command menu. At times, informational messages will be printed in this pane. In the course of use, pop-up windows will also appear periodically with messages or to request information from you. Attimes, the main pane will contain command buttons.

2.2.1
Command Line Arguments

Valid command-line arguments for the Unix Pathway Tools are:

• 
-id
xe "Pathway Tools:Version"Instructs the Pathway Tools to print identifying version information for itself, and then exit.

• 
-patch
Instructs the Pathway Tools to download and install all the latest patches from the public Pathway Tools patch site, and then exit.

• 
-lisp 

Instructs the Pathway Tools to start the Lisp interpreter instead of the Pathway/Genome Nav​igator interface so that the user may enter Lisp expressions, such as queries to Pathway Tools data. To exit from the Lisp interpreter back to Unix, type “(exit)”. This option is not valid during web operation.

• 
-oratest
When the Pathway Tools are configured for operation with an Oracle database, this option attempts to connect to the Oracle server, then lists those Pathway Tools data sets that are present, and then exits. This option is used for verifying that a proper connection to Oracle can be established.

• 
-org orgid
Instructs the Pathway Tools to select the organism whose organism ID is as the current organism. In web mode, this organism will be the default organism selected on the Pathway Tools query page.

• 
-api
This argument sets up the Pathway Tools to accept external queries from a package such as perlcyc. The perlcyc module allows users to write programs in perl that query a PGDB located on a Pathway Tools server running on the same machine as the perl program. Com​munication is by Unix file sockets. Consequently, this functionality is available only under Unix. The perlcyc module is included in the Pathway Tools distribution. For more informa​tion, see http://aracyc.stanford.edu/~mueller/perlcyc.
The following command line arguments are applicable only to Pathway Tools when operating in web mode:

• 
-www
Instructs Pathway Tools to operate in web mode.

• 
-port NNN
This option is valid only when Pathway Tools is operating in web mode and is typically used in conjunction with the -user option. It specifies in NNN the TCP/IP port on which the Path​way Tools web server will listen for requests. By default, port 1555 is used. See the -user argument for security information.

• 
-user NNN
This option is valid only when Pathway Tools is operating in web mode and is typically used in conjunction with the -port option. It specifies in NNN the Unix account that Pathway Tools should use to process web requests. Unix allows only root accounts to listen on TCP/IP ports numbered up to 1024, so if you specify -port 80, for example, then only root can start Pathway Tools, but Pathway Tools will switch to running as user NNN right after starting to listen on port 80.

• 
-proxy-port NNN
This argument is valid only when Pathway Tools is operating in web mode. It specifies in NNN the TCP/IP port on which another web server, such as Apache, will listen for requests and forward them to the port on which the Pathway Tools web server listens for requests. You also have to configure the other web server, such as Apache, to actually forward the requests. Typical use of this command-line argument is to specify -proxy-port 80 to work around firewall restrictions; most firewalls do allow traffic to port 80.

• 
-www-publish pubspec
This argument is applicable when Pathway Tools is running in web mode, and affects which of the available PGDBs are visible through the web server. This argument assists users in complying with the SRI license agreement provision that prevents users from publishing 

PGDBs owned by SRI or DoubleTwist (such as EcoCyc, MetaCyc, or BsubCyc) on their external web site. However, all available PGDBs may be published on a web site that is visi​ble only within their institution.

Examples:

o
Consider a user who has developed a new PGDB and wishes to publish it on their exter​nal web site without making other PGDBs such as EcoCyc visible. In this case, use the following command: pathway-tools -www -www-publish public

This command causes only those databases marked as “public” to be visible through the Pathway Tools web server, which includes all new PGDBs created by the user.

Consider a user who wishes to publish all available PGDBs on their internal web site. In this case, use command: pathway-tools -www -www-publish all

The full set of possible pubspec arguments are:

o
public -- make public PGDBs visible (excludes restricted PGDBs)

o
all -- make all PGDBs visible

o
orgA+orgB+...+orgX -- make the specified set of organisms visible. Each orgX is an organism ID.

• 
-gene-link-db db

When a user site sets up a Pathway Tools database in conjunction with a previously existing database of genes for an organism, it is sometimes useful to have references to genes in Path​way Tools web pages link directly to gene pages in the user's pre-existing database, rather than to the gene pages generated by the Pathway/Genome Navigator. To accomplish this, the user must create a Database frame in the PGDB that contains information necessary for link​ing to the desired external database, and each gene frame in the PGDB must contain a link to the corresponding object in that database. Then, if the database frame ID is supplied as the value of this command line argument, pages generated by the Pathway Tools web server will substitute links to the external database anywhere it would normally link to a gene page. 

• 
-no-blast 
Ordinarily the web query page contains an option to invoke the BLAST program. If access to BLAST from this page is not desired (e.g. if the BLAST program is not installed, or if such functionality is available elsewhere on a website), then supplying the -no-blast option causes it to be removed from the query page. Note that BLAST is disabled by default when the -gene-link-db argument is supplied.

• 
-blast 

Restore access to the BLAST program from the web query page if it was removed by virtue of the -no-blast or -gene-link-db arguments being supplied.

• 
-email support@site
Specifies the email address to which technical and content-related support questions should be addressed. This address will appear on the Pathway Tools web pages.

2.3
Web Server Operation

xe "Pathway Tools:WWW operation"After installation of Pathway Tools is complete, you can start the Pathway Tools web server operation on a Unix computer by typing the following. This command starts an active web server running on your com​puter. The server must be running during the time when you expect users to issue web requests to the server.

pathway-tools -www [args]

The text [args] consists of zero or more command-line arguments, as defined under “ Command Line Arguments” in section 2.2.1. To specify the organism that will be selected by default in the server.html page, use the -org command-line argument. If you are running the web server on your intranet so that it is not acces​sible by users outside your organization (such as because of firewall protection), you almost certainly want to use the additional arguments -www-publish all to instruct the software to make all available PGDBs visible from the server. By default, some PGDBs will not be visible to facilitate compliance with the Pathway Tools license agreement. The preceding section describes the -www-publish argument in more detail.

Users can access the Pathway Tools web server at URL 

http://hostname:1555/server.html

where hostname is the name of the computer at your site on which the web server is running. The page served by that URL provides a number of different ways of querying the Pathway Tools web server, and documentation on how to use the web server. To access this page with a particular organism preselected (i.e. not the default organism specified using the -org command line argument), access http://host​name:1555/<ORGID>/server.html, substituting the ID for the desired organism for <ORGID>.

Note that even when web server operation is desired, the Unix environment must still be properly config​ured for X Windows operation, as described under “ X Windows Basics” in section 2.1. That is, the DIS​PLAY environment variable must have an appropriate value, and an xhost command must have been issued to establish appropriate access permissions. When running in web server mode, we recommend that the X Windows compute host and display host are the same computer. Thus, the X Windows system itself must be actively running on that computer.

When the Pathway Tools web server executes, it will create a window for the Pathway/Genome Navigator on the display host. That window may be minimized (iconified) during operation of the web server, but the window should not be destroyed, nor should you invoke the Exit command from the Navigator.

The Pathway Tools web server will log its requests in the file aic-export/ecocyc/geno​path/released/logfiles/server.log. You may wish to copy the logfiles in this directory to a more permanent location when installing a new version of Pathway Tools.

xe "Pathway Tools:Exiting"To stop the Pathway Tools web server type the command (exit) in the same window in which the orig​inal pathway-tools command was issued. The program will exit back to the Unix shell.

2.3.1
Customizing the Web Server Pages

The pages served by your Pathway Tools web server will in general look similar to those that appear on the BioCyc.org web site. There are however a few ways in which you can customize their content and/or appearance. For the purpose of these examples we assume that your httpd root directory is 

/home/htdocs/.

• 
To link to a page of release notes for a PGDB, create a directory <ORGID>cyc (substituting the ORGID for your PGDB) in your http root directory, if one does not yet exist. Create a file called release-notes.shtml and save it in this directory. For example, if your httpd root direc​tory wisas /home/htdocs/, and your ORGID is TEST, you would save release notes to the file /home/htdocs/testcyc/release-notes.shtml. Users will see this page when they click on “History of updates to this dataset” in the server.html page.

• 
To include a small organism graphic to the left of the page header for each data page, save the image file as /home/htdocs/<ORGID>cyc/organism-image.<gif/jpg/png>, sub​stituting the ORGID of your PGDB, and using the correct file suffix for your image type. Some web browsers can display text over an image when the user’s mouse points to the image; if you want to provide this text for your organism graphic, put the text in file /home/htdocs/<ORGID>cyc/organism-image-text.txt.

• 
The style sheet for Pathway Tools web pages is stored in /home/htdocs/style.css, and may be edited. Note that the colors of generated graphics are set to show up best against a white background.

• 
You may add html text to the beginning and/or end of every generated page by creating files banner.html and/or footer.html in the directory aic-export/ecocyc/geno​path/released/misc/.

• 
You may add html text under the title of the server.html page by creating a file aic-export/ecocyc/genopath/released/misc/server-announcements.html.

2.3.2
Setting up BLAST access

By default, the server.html query page provides the option of performing a BLAST search for some sequence within the genome of a single organism (see the description of the command-line argument -no-blast to disable this functionality). The Pathway Tools distribution does not include a copy of the BLAST software, however. The BLAST package must be downloaded from NCBI (see http://www.ncbi.nih.gov/blast/) and installed such that the executable programs blastall and formatdb are on the Unix path of the user running the Pathway Tools web server. Once BLAST has been installed, the BLAST sequence databases for each organism must be created before web users can access them. From the Tools menu, select Prepare Blast Reference Data => Both.

2.3.3
Troubleshooting

If the Pathway Tools web server malfunctions, please check the following:

If the web server is not functioning at all:

• 
Be sure you have defined the X-windows environment properly

• 
Be sure not to exit from the Pathway/Genome Navigator window

• 
Be sure the /tmp directory is accessible on your computer; the web server writes some tem​porary files there

If some PGDBs are not visible in the “Select a dataset” selector:

• 
Please review the -www-publish argument in the preceding section. It determines which  PGDBs are accessible via the web server.

3

Pathway/Genome Navigator

The preceding chapter describes how to start Pathway Tools, including the Navigator. This chapter describes the basics of how to work with the Navigator and then leads you through several examples, which you should attempt to execute as you read. We will focus on navigating the information contained within the EcoCyc E. coli database.

3.1    Using the Mouse To Navigate and Issue Commands

User interaction with the Navigator is primarily mouse oriented. In general, the left mouse button is used to invoke specific commands and for hypertext navigation, whereas the right button is used to bring up menus of additional operations, where available. The middle button has some specialized uses that will be described later. Items that can be clicked on include elements of the command menu, buttons within dis​play panes, pop-up menus, and textual and graphical elements in display windows. You can tell when an item is mouse sensitive because when you move the mouse pointer over a sensitive item, a bounding rect​angle appears around the item. In some cases, a mouse-documentation line also flashes at the bottom of the window to explain what will happen if you click on the item. For example, move the mouse cursor over the xe "reaction mode"Reaction Mode command of the command menu, and note that a rectangle comes up and surrounds these words. Note also that the following mouse optional operations appear in the bottom pane, L: Retrieve reactions; R: Menu. This indicates that use of the left mouse button allows you to retrieve one or more reactions from the database corresponding to the current database (see below) while use of the right button will bring up a menu that indicates the available options for the current cursor position.

The Navigator may appear not to be responding for several reasons (see “Frequently Asked Questions in Chapter 5). The most common reason occurs periodically and depends on how much memory is available for operation of Pathway Tools. At roughly half-hour intervals, the Navigator pauses to perform a memory management function called 'garbage collection’ that takes approximately 30 seconds to complete.

3.2    xe "menus"Menus and Dialogs

The Pathway/Genome Navigator has a Menu Bar, Single-Choice Menus, Multiple-Choice Menus, and Dialogs, described below. You may encounter Single-Choice Menus, Multiple-Choice Menus, and Dialogs while using the Menu Bar or by right-clicking on the title of a biological object display.

3.2.1    xe "main command menu;menus: Main Command; commands (Navigator): main command menu"Menu Bar

The Menu Bar at the top of the Navigator window contains a pull-down menu for each major biological object type -- Metabolic Overview, Pathway, Reaction, Protein, RNA, Gene, Compound, Chromo​some -- as well as File, Tools, and Help menus containing general commands. For example, clicking on the Reaction menu will reveal a list of query options that apply specifically to reactions.

3.2.2    xe "Single Choice menu; menus: Single Choice"Single-Choice Menus

This type of pop-up menu lets you select a single item from a list. As soon as you left-click on an item, the selection is made and the menu vanishes.

3.2.3    xe "Multiple Choice menu; menus: Multiple Choice"Multiple-Choice Menus

This type of pop-up menu allows you to select one or more items from a list. Click on as many items as you want; when you have finished selecting, click on the OK button at the bottom. If you change your mind and want to deselect an item before you have clicked OK, simply click on the item a second time.

3.2.4    Dialogs

A Dialog allows you to answer several questions in one window. Alternative answers are presented, with default answers in boldface. Click on a different answer to override the default. When all questions are answered, click OK at the bottom of the menu.

3.2.5    xe "menus: aborting out of"Aborting out of Menus and Dialogs

If the Pathway/Genome Navigator is requesting input from you via a Menu or a Dialog and you want to abort out of it, try one of the following actions:

• 
Click Cancel or No Select.

• 
Type ^Z  (i.e., hold down the control key and press the “Z” key while the control key is still held down).

• 
Click the top of the Menu or Dialog

• 
Click outside the Menu or Dialog.

3.3    xe "All Organisms display"Organism Summary Display

[image: image4.wmf]
When you invoke the Navigator, the main window contains the Organism Summary display (see Figure    3-1). 

Figure 3-1: Organism Summary display

At the top of the Organism Summary display is the Pathway Tools banner, and directly below it are the Organism Grouping and Copyright Notice commands. Directly below these commands, a list of available databases is displayed. The first column lists the names of available databases. To the right are additional columns labeled from left to right: Pathways, Genes (ORF %), and Genome Size (bp). Each row gives the number of pathways (computationally predicted and user created), the number of genes (and the percent​age of these that represent open reading frames (ORFs)), and the genome size in base pairs. At the top of the command menu, the Current Organism is listed. By default, the xe "current organism"Current Organism is EcoCyc.

To return to the Organism Summary display from any Navigator window, use the command File->Sum​marize Databases.

3.4    xe "Single Organism display"Single Organism Display

The Single Organism display summarizes the content of the database for an individual organism (see Figure 3-2). 
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Figure 3-2: Single Organism display

The top of the Single Organism display gives the organism name and the specific strain whose genome and predicted metabolic pathways are available as a database. Directly below is the Pathologic Summary Pages command (available from the Single Organism display of PGDBs but not from the E. coli data​base). Clicking on this option takes you to a series of HTML pages that outline the genomic evidence for the metabolic pathways of this organism. The Replicon column lists sequenced replicons (chromosomes and plasmids) of the organism; for example, in the case of S. cerevisiae (yeast), all 16 chromosomes and the mitochondrial chromosome are listed. For each such element, summary information on its genes is pro​vided in additional columns, that is, the number of mapped genes, a breakdown of this number between protein coding and RNA coding genes, and the number of unidentified ORFs. The size (in base pairs) is also listed. Clicking on an element name takes you to a window display of the genomic map of that ele​ment (see “Genomic-Map Displays” in Section 3.8.10). For example, clicking on Chromosome XVI of the S. cerevisiae summary display takes you to a display of the genomic map for chromosome XVI.

The xe "Single Organism display"Single Organism display for an organism is accessible from the All Organisms display by left-clicking the name of this organism in the Organisms column of the All Organisms display. The Single Organism display for the selected organism then replaces the All Organisms display in the main display window. In addition, this organism becomes the Current Organism.

3.5    Notion of xe "current organism"Current Organism

 Pathway Tools always keeps track of what it considers to be the current organism for processing. The identity of the current organism is important in two respects. First, all command-mode queries are directed against the database for this organism and, second, for comparative analyses this database serves as the reference for comparison with one or more other-user-specified databases. However, when you follow hypertext links within the Navigator (such as by clicking on the name of an enzyme within a pathway drawing), the next object displayed (the enzyme) is always from the same organism as the organism con​taining the previous object (the pathway). This organism is not necessarily the current organism.

When you first enter the Navigator, by default the current organism is E. coli. This means that all queries will be directed against the database for this organism. To change the current organism, select a database for a different organism from the All Organisms display (see above) or go to the top of the command menu where the name of the current organism is listed within the Organism Selector. Left-click once on this name to bring up a listing of all available databases and left-click once on the name of the organism to make it the new xe "current organism"current organism. The last organism selected in this way or via the All Organisms display is the current organism. Its name is displayed in the Organism Selector at the top of the command menu. An asterisk (“*”) next to the name of an organism in the Organism Selector means that the KB for that organism has unsaved changes.

To explore the pathway/genome information space of a given organism, it must be the current organism. If E. coli is no longer the current organism, set it as such to work through the rest of this chapter. All the Nav​igator commands outlined below for navigating, querying, visualizing, and analyzing the E. coli database may also be used to explore any one of the other available databases, except MetaCyc (which does not contain information on objects that are not relevant, for example, replicons).

3.6    Examples

In the following examples it is assumed that the main Navigator window is now visible on your monitor and that the E. coli database is current. These examples are designed to introduce you to some basic Navi​gator features that allow you to retrieve and view information from the E. coli database.

Example 1 
Invoke the menu command Reaction->Search by EC#, which allows you to look up a reaction by its Enzyme Commission number. A pop-up window appears: type “5.3.1.9” and click OK. (If nothing hap​pens when you type, you may have to move the mouse pointer into the pop-up window, and/or click on its title bar).

A display window for the reaction catalyzing the first step of glycolysis will appear. A number of items in this display are mouse sensitive, including the names of enzymes that catalyze the reaction, the genes that encode these enzymes, the pathway containing the reaction, and the compounds in the reaction equation. Click on any of these items to see displays of the respective objects, such as the glycolysis pathway.

Example 2 
Invoke the command Pathway->Search by Class. A pop-up menu gives a classification hierarchy for metabolic pathways.

Select a class, for example Amino Acids->Individual amino acids (under Biosynthesis). A new pop-up menu lists a number of individual pathways for amino-acid biosynthesis (the instances of this class). Click on one of the pathways.

A drawing of the selected pathway appears. Virtually every item in the drawing is mouse sensitive. For example, you can click on a reaction arrow to see a display of that reaction, and you can click on an enzyme name to see a display of that enzyme.

Example 3 
Invoke the command Protein->Search by Substring. In the pop-up menu, type “pyruvate”. A second pop-up menu lists all proteins (including enzymes) listed in the E. coli database whose name (or one of its alternate names) contains the substring pyruvate. Click on any protein name, and then click on OK at the bottom of the menu, to display that protein.

Scroll downward in the pane for this protein (scroll by clicking on the small arrow at the bottom of the scroll bar). Click on one of the gene names. When the gene window appears, click on the map position of the gene (assuming your gene has a map position).

When the genetic-map display appears, you can zoom in on a region of interest by middle-clicking on a gene name, or by left-clicking on the chromosome bar. You can obtain detailed information on a gene by left-clicking on a gene name.

3.7    xe "query facilities"Query Facilities

When in search of a particular piece of information about E. coli metabolism, we can usually try two dif​ferent strategies to find that information: a direct and an indirect approach.

Using the direct approach, we issue queries for the entity we seek. For example, imagine that we seek information on the hisA gene, such as its map position and the name of the enzyme it encodes. The Naviga​tor allows you to call up an information window for a gene by its common name (or by other names by which that gene is known).

Using the indirect approach, we bring up the information window for an object by first issuing a direct query for a related object, and by then navigating to the object of real interest. For example, imagine that we had forgotten the name of the hisA gene, but we knew it coded for the enzyme that catalyzed the last step in the biosynthesis of histidine. We could use a direct query to display the biosynthetic pathway for histidine, and then click on the name of the enzyme at the last step in the reaction. The resulting informa​tion window for that enzyme names the gene (hisA) coding for the enzyme. Clicking on the gene name dis​plays the information window for hisA.

In summary, by using the Pathway/Genome Navigator we can traverse many paths through the E. coli database to arrive at the same information.

3.7.1    xe "direct queries"Direct Queries

To query a given type of object, you must select from the menu associated with that class of object. The object type menus are 

• 
Overview

• 
Pathway

• 
Reaction

• 
Protein

• 
RNA

• 
Gene

• 
Compound

• 
Chromosome 

Each menu contains a set of type-specific predefined queries. For example, from the xe "compound mode"compound menu, you can query compounds by any of these criteria: 

• 
An exact compound name or ID

• 
A substring within a compound name

• 
A chemical substructure specified using the SMILES chemical notation [17] (all compounds containing that substructure will be returned as the result of the query)

• 
A compound class chosen from a menu-based classification hierarchy of compounds (such as amino acids, carbohydrates, and nucleotides)

• 
An advanced search that includes some combination of name, molecular weight, chemical formula and substructure.

Note that most commands that allow you to query objects by their exact name allow you to enter in several names within one pop-up window, separated by commas, for example, “hisA, hisB, hisC.” The exception is the compound menu, because many compounds have commas within their names.

3.7.1.1    Queries with Multiple Answers
Some queries return more than one object as the result. For example, most modes allow you to query objects by a substring search, such as searching for all proteins with “pyruvate” in their names. In this instance, the Navigator creates a menu that lists the proteins satisfying the query. The menu allows you to select one, some, or all of the proteins — click on individual protein names to select them, or click on Select All to select all of them (clicking on an already-selected name will deselect it). When you have fin​ished selecting, click on Use These Values.

The Navigator immediately displays one or more of the proteins you selected (see “Pane Layout” in section 3.9.9.1 to find out how to divide the main display window into multiple panes; see “History and Answers Lists” in section 3.9.9.9 for information on how to control the number of objects displayed by Next Answer). It remembers the others on a list called the Answer List. When you want to see the next protein on the Answer List, click on Next Answer in the command menu. For more information about the Answer-List, see “Answer-List” in section 3.9.2.

3.7.2    xe "indirect queries"Indirect Queries: Navigation

The information window for each object usually lists a number of related objects. For example, the win​dow for a gene shows the product of that gene; if the product is an enzyme, then the reaction(s) catalyzed by the enzyme is listed, as are the pathways in which that reaction occurs. Similarly, a compound window lists the reaction(s) that produce and consume that compound, and the pathway(s) in which the compound is found.

Each of these related objects is “live” in the sense that clicking on the object displays an information win​dow for that object. Objects are color coded by type to make their relationships more evident, and to make it more obvious which visual elements within a complex display are mouse sensitive. A bold-face font is used instead for mouse-sensitive objects, when monochrome monitors are used.

On occasion, nothing happens when you click on a related object. The reason is most likely that the E. coli database has no information about that object, although that incompleteness should be remedied in a future version.

3.7.3    xe "history: history list"History List

The Navigator keeps a list of the last few objects that you have displayed. This list is called the history list. You can return to a previously displayed object by clicking on the xe "history: backward in history"Back button. For example, if there are three items on the history list, clicking on Back three times returns you to the window you started with. Clicking on xe "history: forward in history"Forward moves you through the history list in the other direction. To select one or more arbi​trary objects from the history list, click on the History button. You are presented with a multiple-choice menu of every item on the history list. To see the current history list, select Tools->History->Show on Console.

By default, the history list contains as many as fifty items. This length can be changed (see “History and Answers Lists” in Section 3.9.9.9).

When you exit the Navigator, your history list is saved in a file called .ecocyc-history in your home directory. This feature enables you to easily start up again at the same place where you left off.

3.7.4    xe "complex queries"Programmatic Queries

The examples below of different complex queries against Pathway/Genome Databases are written in the Common Lisp programing language. To write programmatic queries, you must understand a number of aspects of Pathway/Genome Database schemas, such as class and slot names. The current schema is described in Appendix A.

The Preface lists a variety of additional reference sources relevant to writing Lisp queries, including a longer set of example queries that are available through the SRI Web site.

One convenient way to examine the answer to a query is to put the result of the query on the Answer List of the Pathway/Genome Navigator, and to look at each answer using the Next Answer command. The first query below shows how to do so. 

;; Find genes located between 20 and 30 centisomes on the map 

(loop for gene in (get-class-all-instances ’|Genes|)

      for pos = (get-slot-value gene ’centisome-position) 

      when (and pos (> pos 20) (< pos 30)) 

      collect gene) 

;; The preceding query returns a list of genes. To run the Pathway/ ;; Genome Navigator with those genes on the Answer list, 
;; evaluate the following. The "*" means "the result returned by 
;; the last expression evaluated". 

(eco :answer-list *) 

;; Find reactions involving pyruvate as a substrate 

(loop for rxn in (get-class-all-instances ’|Reactions|) 

      when (member ’pyruvate (get-slot-values rxn ’substrates)) 

      collect rxn) 

;; Find all genes whose products catalyze a reaction involving 

;; pyruvate as a substrate 

(loop for rxn in (get-class-all-instances ’|Reactions|) 

      for genes = (genes-of-reaction rxn)     

      when (member-slot-value-p rxn ’substrates ’pyruvate) 

      append genes) 

;; Find all enzymes that use pyridoxal phosphate as a cofactor 

;; or prosthetic group 

(loop for protein in (get-class-all-instances ’|Proteins|) 

      for enzrxn = (get-slot-value protein ’enzymatic-reaction) 

      when (and enzrxn 

                (or (member-slot-value-p enzrxn 

                           ’cofactors ’pyridoxal_phosphate) 

                    (member-slot-value-p enzrxn 

                           ’prosthetic-groups ’pyridoxal_phosphate)

                    ) ) 

      collect protein) 

3.8    xe "object displays and queries"Object Displays and Queries

Specific queries can be issued in each command mode and result in different object displays.

3.8.1    Shared Display Characteristics

Certain aspects of the object displays are shared by most or all of the different object classes.

3.8.1.1     xe "gene-reaction schematic"Gene-Reaction Schematic

The many-to-many relationships among genes, enzymes, and reactions can be complex. An enzyme com​posed of several subunits might catalyze more than one reaction, and a given reaction might be catalyzed by multiple enzymes. The Gene-Reaction Schematic depicts the relationships among a set of genes, enzymes, and reactions (see Figure 3-3 and  

http://ecocyc.org:1555/new-image?type=REACTION-IN-PATHWAY&object=DAHPSYN-RXN ). 

It is drawn in reaction windows, protein windows, and gene windows. It is generated by starting with the object that is the focus of the current window (which is highlighted in the schematic), and then recursively traversing database relationships from that object to related objects, such as from a gene to its product, or from a reaction to the enzyme(s) that catalyzes it. The schematic summarizes these complex relationships succinctly, and also constitutes a navigational aid: click on an object in the schematic to cause the Naviga​tor to display that object.
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Figure 3-3: A gene-reaction schematic

In gene-reaction schematics, the boxes to the left represent reactions, the boxes on the right represent genes, and the circles in the middle represent proteins. The lines indicate relationships among these objects. For example, the schematic in Figure 3-3 means that the aroF gene encodes a polypeptide (the cir​cle to the left of the box for the aroF gene) that forms a homodimer (the next circle to the left — the 2 indi​cates two copies) that in turn catalyzes reaction 4.1.2.15. The situation for the aroG gene is similar except that its product forms a homotetramer. Gene-reaction schematics that depict heteromultimers show more than one gene-product circle connected to a single circle for a protein complex. Gene-reaction schematics also include modified forms of a protein (or tRNA) when relevant. For example, the schematic for the acyl carrier protein shows a yellow circle for the unmodified form of the protein, and it shows 13 orange cir​cles, which represent different modified forms of the protein.

xe "gene-reaction schematic"Gene-reaction schematics should not be confused with pathway diagrams; although both diagrams are graphs, they mean different things.

3.8.1.2    Use of the xe "Internet"Internet

Rather than being stored directly in the E. coli database, some information, such as medline citations and links to other databases, is retrieved dynamically from public sites on the World Wide Web. To accom​plish this, you can invoke your Web browser. If you do not already have a Web browser running, it will start when you access one of these links (this may entail a short delay). If a Web browser is already run​ning, the Navigator will request that a new browser window be created to display the E. coli related infor​mation. All subsequent Internet requests will attempt to   use that same browser window.

3.8.1.3    xe "citations"Citations and xe "comments"Comments

Because citations and comments are found in all types of objects within organism databases, we begin by discussing them.

Comments authored by database curators are found in several locations in object displays. In some cases, citations are presented in the same manner as are comments. Consider a line from an enzyme display such as 

        Inhibitors (allosteric) [3]: NADH [4], succinate [2,C1] 

This line is identifying NADH and succinate as allosteric inhibitors of the enzyme being shown. The [4] indicates that the E. coli database contains a citation that pertains to the fact that NADH is an allosteric inhibitor of the enzyme. When the mouse is over the “4”, the pointer documentation window at the bottom of the screen shows the start of the citation information. Clicking on the “4” navigates to where the full citation information is displayed in the References section at the bottom of the page.  Clicking on the full citation information displays the citation in a pop-up window or, if the citation is available through PubMed, in a Web browser window. Analogously, a comment and citation pertain to the role of succinate as activator or inhibitor: [2,C1]. Passing the mouse over the "C1" shows the start of the comment in the pointer documentation window, and clicking on brings up the full comment in a pop-up window.  The [3] is a more general citation about the inhibition of the enzyme that does not pertain precisely to NADH or succinate alone.

xe "citations"Citations of general relevance to an object (as opposed to citations that pertain to a particular property or data value) are shown on a separate line in the object display window, such as 

        Citations: [1,2,3,4] 

Note that citation indicators can be either numeric or mnemonic.  To choose the style of citation indicator you prefer, use the command Tools->Preferences->Citation Reference Style.

3.8.1.4    xe "database links"Database Links

Objects within the E. coli database contain links to a variety of other databases. For example, some E. coli polypeptides are linked to both xe "Swiss-Prot: entries"SwissProt and PDB entries; some E. coli genes are linked to entries in the Coli Genetic Stock Center database. These databases are not part of, or provided together with, Pathway Tools and may require a license from their owners or distributors to access their contents.

In general, databases contain two types of links: xe "unification links; links: unification"unification and xe "relationship links; links: relationship"relationship [4]. Unification links are links to descriptions of the same object in the other database, and are displayed in a line that lists one or more links, where each link displays the name of the other database, and the unique identifier of the target object in that database, such as 

        Unification links: SwissProt.P34554 

Relationship links refer to a related object in the remote database. Because a number of possible relation​ships might exist between the source object in the E. coli database and the target object in the other data​base, the line describing relationship links displays the name of the foreign database, the ID of the target object, and the name of the relationship to the target object. For example, some E. coli polypeptides are linked to PDB homologs if PDB does not describe the structure of this exact E. coli protein: 

        Relationship links: PDB-Homolog.P34554 

When you click on the target identifier, the Web browser displays the target object (clicking on the target identifier will invoke Netscape and then cause Netscape to display the target object).

3.8.1.5    xe "classes"Classes

The E. coli database contains a number of xe "taxonomic hierarchies"taxonomic hierarchies. Reactions are classified according to the Enzyme Nomenclature system [16]. Genes are classified according to a system devised by Riley [13]. Compounds and pathways are also classified. All the xe "classification systems"classification systems are multilevel, and involve a number of instances (such as reactions) that are assigned to a number of classes (such as those defined by the Enzyme Nomenclature system). Many of these classes in turn are assigned to superclasses (which may recursively be assigned to additional superclasses).

Each object display shows the parent xe "classes"class(es) of that object. Clicking on a parent class  displays the parent class. The display window for a class lists both its parent classes and its instances, if any. You can also click on these parent classes, or instances, to display them. In this manner, you can user can navigate the E. coli taxonomic hierarchies.

3.8.2    The xe "Metabolic-Map Overview diagram"Cellular Overview

The Overview diagram is a representation of all metabolic pathways and reactions, signaling pathways, membrane proteins and transporters defined for the current organism. In this diagram, each circle, square, ellipse, and so on represents a single metabolite. The shape of the icon encodes the chemical class of the metabolite, as listed in Table 3-1. 

Table 3-1: Compound shapes used in the Overview Diagram

	Icon Shape
	Compound Class

	square
	carbohydrate

	triangle
	amino acid

	upside down triangle
	cofactor

	ellipse (horizontal)
	purine

	ellipse (vertical)
	pyrimidine

	diamond
	protein

	T-shape
	tRNA

	circle
	all other compound types


The shading of the icon indicates whether the metabolite is phosphorylated: shaded compounds are phos​phorylated; unshaded compounds are unphosphorylated. 

Each thick line in the Overview diagram represents a single bioreaction. Neither the circles nor the lines are unique in the sense that a given metabolite (or a given reaction) may occur in more than one position in the diagram. 

The “barbells” along the right side of the diagram represent individual metabolic reactions that have not been assigned to a particular pathway. They are presented as single reactions because their direction and role are determined by the metabolic condition of the cell. The barbell region also contains some reactions of macromolecule metabolism, such as DNA metabolism. In the region to the left of the barbells, the glyc​olysis and the TCA cycle pathways in the middle separate predominately catabolic pathways on the right from pathways of anabolism and intermediary metabolism on the left. The existence of anaplerotic path​ways prevents rigid classification. The majority of the metabolic pathways operate in the downward direc​tion.  Pathways are generally grouped by class, and the extent of a class is indicated by background shading.

The border drawn around the Overview depicts the cytoplasmic membrane, and contains embedded trans​port proteins. Transported substrates use the same shape codings as for metabolic substrates. Where possi​ble, transporters are positioned in the membrane so as to be near some of the metabolic reactions into which their substrates feed.

In the EcoCyc Overview, both the inner and outer membranes are shown.  Periplasmic reactions and proteins are depicted in the space between the two membranes at the right of the diagram.

You can interrogate the Overview in several ways. To identify a compound within the Overview, move the mouse pointer over a geometric figure in the diagram — the Navigator will print the name of the metabo​lite and the name of the containing pathway at the bottom of the screen. To identify a reaction, move the mouse pointer over a thick line — the Navigator will print the equation of that reaction, and the name of the containing pathway.  If the mouse pointer is moved over a shaded but blank region, the Navigator will print the name of the pathway class.

If you left-click on a compound or a reaction in the Overview, that object is displayed in its own display window.

Conversely, if you are looking at another display that contains a link to a compound, reaction or pathway, you can right-click over the link to bring up a short menu of operations. One of those operations is “Show compound/reaction/pathway in overview”. Selecting that menu item causes the Overview diagram to be drawn, with the designated entity highlighted.

If you middle-click on a reaction in the Overview, its enzymes and genes are listed in the listener window. The enzyme and gene names are also left-clickable, to allow you to navigate to the displays for those objects.

3.8.2.1    xe "overview mode commands; commands (Navigator): overview mode"Overview Commands
• 
Show Overview: Draw the Overview diagram for the current organism.

• 
Show Key: Displays a pop-up window containing a key for the xe "Overview diagram"Overview diagram that explains what compound classes are denoted by each node shape, and explains what the dif​ferent highlighting colors represent.

• 
Show/Hide Transport Links: Toggle whether or not faint lines are shown connecting trans​ported substrates to the pathway(s) in which they participate.  By default, these links are hid​den.

• 
Highlight: You can request that some entity be highlighted in the Overview. You can request that a compound, a reaction, a pathway, an enzyme (i.e., the reaction(s) catalyzed by the enzyme) or a gene (i.e., the reaction(s) catalyzed by the product of a given gene) be high​lighted. The object to be highlighted can be specified in a number of ways (e.g., by name, by substring, by EC number) using a set of cascading menus that reproduce many of the query capabilities present in the other command modes. Specifically, the highlighting commands are 

o
Species Comparison: (see “Comparative Operations” in Section 3.10) 

o
Pathway 

-
By Name or Frame ID

-
By Substring

-
By Class

-
All by Class (colors all pathways according to their role, for example, all amino-acid biosynthetic pathways are in one color)

-
By Genome Clustering (colors pathways according to the clustering within the genome of the genes that encode their enzymes — the accompanying pop-up window describes the color scheme in more detail)

o
Reaction(s) 

-
By Enzyme Name

-
By Enzyme Substring

-
By EC Number (e.g., reaction with EC number 1.2.3.4)

-
Using EC Class Hierarchy (e.g., all reactions in class 1.2)

-   All by Top-Level EC Class (colors the entire diagram to reflect the chemical type of each reaction)

-
From File of EC#s (takes as input a file containing EC#s, one per line)

-
All without EC Numbers (of which there are many in the E. coli database because the Enzyme Commission has yet to assign EC numbers to many reactions)

-
By Pathway (e.g., all reactions that occur in the TCA cycle)

-
By Substrates (this option allows you to specify a full or partial list of the reactants and products of the reaction)

-
By Effects of Compound(s) on Enzyme Activity (this option allows you to highlight reactions according to modulation of the enzyme(s) that catalyze the reaction, e.g., to highlight all reactions whose enzyme is activated by ADP)

-
By Enzyme Cellular Location (highlights reactions whose enzymes are known to be located in a user-selected cellular location)

-
All with Multiple Isozymes

-
All in Multiple Pathways (highlights reactions that occur in more than one pathway)

o
Gene

-
By Name or Frame ID

-
By Substring

-
By Class

-
By Genetic Regulator Protein (allows you to select a transcription factor, and high​lights all reactions whose genes are in operons that are regulated by that tran​scription factor)

-
Gene List From File (the file should contain a list of gene names, one per line) 

-
All by Replicon (colors reactions according to the replicon —  chromosome or plas​mid — on which their genes are located)

o
Compound(s) 

-
By Name or Frame ID

-
By Substring

-
By SMILES Structure

-
Using Class Hierarchy (e.g., all amino acids) 

o
Undo: Unhighlights the last item or set of items that were highlighted in the Overview.

o
Redo: Rehighlights the last item or set of items that had just been removed via the Undo  command.

o
Clear All: Unhighlights all items in the Overview.

o
Save to File: Saves a given pattern of overview highlighting on to a file.

o
Load from File: Inputs a file created using the Save to File command. This restores the specific pattern of overview highlighting previously saved to this file. 

• 
Omics Viewer: Overlay Experimental Data from: xe "expression data"Experimental data, such as gene expression, proteomics, reaction flux or metabolomics data, is read from a file and reactions and/or compounds are colored according to the experimental values (absolute or relative) associated with the corresponding genes, proteins, reactions or compounds. See section 3.8.2.3 on viewing experimental data using the Omics Viewer. The two options are:

o
Text File

o
SAM Output File

• 
Update...: Regenerate the Cellular Overview diagram to reflect any changes in the database.  

This command is disabled if the database cannot be modified.  Note that this operation can take quite a long time -- from several minutes up to an hour or so, depending on the speed of the computer and the number of pathways in the database.

Additional operations are accessible through the right mouse button. Right-clicking on a compound gives you the choice of accessing either a menu for the compound or a menu for the pathway. Right-clicking on a reaction gives you the choice of accessing a menu for the reaction, for the pathway, or for any of the compounds involved in the reaction (including those that are not displayed in the overview because they are side compounds). Right-clicking on any object also gives you the opportunity to zoom in or out of the overview.  You may choose from one of several predefined magnification levels or you may specify your own.  Zooming changes the scale of the display, but does not cause any additional information to be printed. 

The compound, reaction, and pathway menus are all described below.

• 
Right-Button Compound menu:

o
Display compound information in main display: Displays the selected compound in the main display window.

o
Display compound information in pop-up window: Displays the selected compound in a new pop-up window.

o
Highlight all reactions of this compound: Highlights all reactions that contain this compound as either a main substrate or a side substrate. This command is a more com​plete way of finding reactions of a compound than is the next command.

o
Highlight this compound everywhere it appears as a main: Highlights all occur​rences of this compound as a main substrate only.

o
Display all connections for this compound: Highlights all occurrences of this com​pound as a main substrate, and draws dim lines connecting the clicked-on compound to all other occurrences of that compound, including situations in which the compound is a side substrate of a reaction (in this latter case, there is no icon for the selected com​pound, so the line is drawn to some other main compound icon in the relevant reaction). The lines are removed when the highlight operation is cleared or undone. These new lines are drawn slightly brighter than those used to link identical compounds to show flow of material between pathways.

o
Show: Invokes the usual right-button Show submenu for the compound. This submenu is described in section 2.4.3 in volume II of the Pathway Tools User Guide.

o
Edit: Invokes the usual right-button Edit submenu for the compound. This submenu is described in section 2.4.3 in volume II of the Pathway Tools User Guide.

• 
Right-Button Reaction menu: 

o
Display reaction information in main display: Displays the selected reaction in the main window.

o
Display reaction information in pop-up window: Displays the selected reaction in a new pop-up window.

o
Highlight this reaction everywhere it appears: Highlights all occurrences of the selected reaction in the xe "Overview"Overview.

o
Show enzymes and genes of this reaction in listener window: Prints the names of the enzymes that catalyze this reaction, and the genes that encode those enzymes.

o
Highlight reactions involving genes in same operon/regulon: Highlights in one color all genes that are in the same operon as the gene whose enzyme catalyzes the selected reaction; highlights in a second color all genes that are in the same regulon as the gene whose enzyme catalyzes the selected reaction. If the selected gene is in more than one regulon, you are asked to select the transcription factor defining the regulon of interest (a regulon is defined as the set of operons regulated by a specified transcription factor).

o
Show: Invokes the usual right-button Show submenu for the reaction. This submenu is described in section 2.4.3 in volume II of the Pathway Tools User Guide.

o
Edit: Invokes the usual right-button Edit submenu for the reaction. This submenu is described in section 2.4.3 in volume II of the Pathway Tools User Guide.

• 
Right-Button Pathway menu: 

o
Display pathway information in main display: Displays the pathway containing the selected compound or reaction in the main window.

o
Display pathway information in pop-up window: Displays the pathway containing the selected compound or reaction in a new pop-up window.

o
Highlight this pathway: Highlights the pathway containing the selected compound or reaction.

o
Display all connections for compounds in this pathway: Draws faint lines connecting most compounds in the pathway to all other occurrences of those compounds, including situations in which the compound is a side substrate of a reaction (in this latter case, there is no icon for the selected compound, so the line is drawn to some other main com​pound icon in the relevant reaction). Compounds in the pathway for which these lines are not drawn are either common small molecules (e.g., phosphate, water) or compounds whose function in the pathway is purely to act as a donor or acceptor of some small moi​ety (e.g., ATP as a donor of phosphate, glutamine as a donor of nitrogen, acetyl-CoA as a donor of CoA). The lines are removed when the highlight operation is cleared or undone. Lines from main compounds in the pathway are drawn slightly brighter than those used to link identical compounds to show flow of material between pathways; lines from side compounds in the pathway are drawn slightly dimmer.

o
Show: Invokes the usual right-button Show submenu for the pathway. This submenu is described in section 2.4.3 in volume II of the Pathway Tools User Guide.

o
Edit: Invokes the usual right-button Edit submenu for the pathway. This submenu is described in section 2.4.3 in volume II of the Pathway Tools User Guide.

3.8.2.2    Displaying Reactions Corresponding to a Set of Genes

To highlight a set of reactions corresponding to some gene set (such as reactions catalyzed by a set of essential genes or knockout genes), use the Overview->Highlight->Gene->Gene List from File com​mand. The command highlights all metabolic reactions catalyzed by the product of a gene listed in the file.

3.8.2.3    The Omics Viewer: Using the xe "Metabolic Overview"cellular Overview to xe "expression data: viewing"View Experimen​tal Data

Note: In earlier versions of the software, the Omics Viewer was known as the Expression Viewer. It has since been extended to display many other types of experimental data, not just gene expression data, so has been renamed.

The Pathway Tools Omics Viewer uses the Cellular Overview for an organism to illustrate the results of high-throughput experiments in a global metabolic pathway context. Genes (in the case of a gene expres​sion experiment) and proteins (in the case of a proteomics experiment) that are involved in metabolism are mapped to reaction steps in the Cellular Overview, and the range of data values levels in a given experi​mental dataset is mapped to a spectrum of colors. Reaction steps in the Cellular Overview are colored according to the corresponding data value. Similarly, for metabolomics experiments, compound nodes are colored according to the data value for the corresponding compound. This facility enables the user to see instantly which pathways are active or inactive under some set of experimental conditions. 

The Omics Viewer can be used for: 

• 
Microarray Gene Expression Data: Reaction lines (and protein icons, where present) are color-coded according to the relative or absolute expression level of the gene that codes for the enzyme that catalyzes that reaction step. The Omics Viewer allows a scientist to interpret the results of gene-expression experiments in a pathway context. 

• 
Proteomics Data: Reaction lines (and protein icons, where present) are color-coded accord​ing to the concentration of the enzyme that catalyzes that reaction step. 

• 
Metabolomics Data: Compound icons are color-coded according to the concentration of the compound. 

• 
Reaction Flux Data: Reaction lines are color-coded according to reaction flux values. 

• 
Other Experimental Data: Any experiment, high-throughput or otherwise, in which data values are assigned to genes, proteins, reactions or metabolites can be viewed in a pathway context using the Omics Viewer. 

The Omics Viewer can show absolute data values (such as the concentration of a metabolite or protein, or the absolute expression level of a gene), or it can be used to compare two sets of experimental data by computing a ratio and mapping the ratios onto a color spectrum.  Multiple sets of experimental data can be superimposed on the same overview diagram so that users can, for example, combine gene expression and metabolomics in the same figure, or view the results of two different microarray experiments together.  When combining multiple datasets, users should be careful to assign color schemes that avoid ambiguity.

The superposition of multiple sets of experimental data on the metabolic overview can also be animated to show, for example, how gene expression levels of enzymes change with time over the course of an experi​ment. The animation can be exported to HTML so that it can be published on the Web.

3.8.2.4    xe "expression dataset file format"OMics Dataset File Format

Experimental data is imported from a file provided by the user that is stored on the user's computer. Each line of the file contains data for a single gene, protein, reaction or metabolite, and is of the form

<name-or-ID>      <data-column1>...
<data-column N> 

Columns are separated by the Tab character. The first column contains the name, or a known synonym for the name, or the unique identifier, of a gene, protein, reaction or metabolite. Gene IDs from sequencing projects (such as the E. coli B-numbers) are generally acceptable and unambiguous. For protein or reaction data, EC numbers may be used. 

The numbers in the data columns can represent either absolute or relative data values. If the numbers rep​resent absolute numbers, then the software can compute relative values from two data columns. An entry (a row of data for an entity) may contain any number of data columns, but only the specified (one or two for a single experiment display, more for an animation) data columns can be visualized at one time. Reus​ing the same file in consecutive viewings improves display performance, as the file needs to be read only once.

Lines that start with either # or ; are taken to be comments and are ignored by the program. The software uses the first row of data (i.e., the first line that is not a comment line) to determine the number of data col​umns to process. For example, if the first row contains five columns, only the first five columns of each subsequent row will be processed. Thus, even if not all fields for the first row contain data, you must make sure that it contains the appropriate number of Tab characters.

3.8.2.5    Using gene expression Data from a SAM spreadsheet 

The Omics Viewer can import gene expression data from a spreadsheet generated by the SAM (Significant Analysis of Microarrays) Microsoft Excel plug-in (see http://www-stat.stanford.edu/~tibs/ SAM/). This package combines multiple expression experiments to produce a list of statistically significant positively and negatively regulated genes. The Omics Viewer displays the positively regulated genes in one color, and the negatively regulated genes in another color. In order to import data generated using SAM, the SAM results sheet must be saved out from Microsoft Excel in text format (not in Excel format). You can then select the SAM option for input to the Omics Viewer, and supply the filename.

3.8.2.6    Color Scales

By default, the color scale used depends on the type and range of the data. Thus, for example, a particular color may correspond to one gene expression level for one data set, and a different gene expression level for another data set, depending on the range of values in each data set. Alternatively, you can specify a color scheme to use, either by simply specifying a maximum color cutoff, or by supplying a list of cutoff values and their corresponding colors. By default, we use the spectrum from yellow/green to red, with yel​low representing the lowest values or ratios in the data set, and red representing the highest. Reactions for which no data was provided are data values is shown in the Overview Key, which pops up automatically when experimental data is displayed if it is not already visible.

For absolute data values, the spectrum is mapped evenly along a log scale between the log of the smallest value in the data set to the log of the largest value in the data set. (The key shows actual values, however, not their logs, unless the supplied data is in log form to begin with.) For relative data values, the ratio is fixed at 1 (or 0, for log values) at the center of the scale.

In many cases, several genes or enzymes, each with its own expression level or concentration, will map to a single reaction.  This is because the reaction might be catalyzed by an enzyme complex made of several gene products, or the reaction might be catalyzed by several isozymes, each with its own gene or genes. Since a reaction can be shown in only a single color, the following method is used to choose which of sev​eral values to display. For absolute data values, the maximum value is displayed; for relative data values,  the value whose log has the greatest deviation from zero is displayed, under the assumption that the user is primarily interested in identifying the genes whose expression levels differ most between the two data sets.

3.8.2.7    Usage

To create an experiment view, select Overview->Omics Viewer: Overlay Experimental Data from, and specify whether data will be from a text file or from a SAM output file. A dialog box pops up with the fol​lowing fields (assuming data is from a text file — only a filename is needed for SAM output):

• 
Experiment Title: Enter a few words to describe the data being viewed. The title is dis​played in the appropriate section of the Overview Key. This field is optional.

• 
Type of display: Select either Single Experiment or Animation.

• 
Type of data: Select either Relative or Absolute. Some of the later options in the dialog box, as well as the color scale used, will depend on this choice.

• 
File: Click on the button to select a file containing the experimental data. The Help button describes the required file format.

• 
Reload?: This option is available only if the specified file has already been loaded (i.e., if you previously displayed data from the same file). If not selected, the previously cached data is used. Select this option if the file has changed since it was last read.

• 
Column zero contains: The data file format requires that the first column (column zero) contain either gene, protein, reaction or compound names or IDs. Specify which your data file contains.  If your data file contains multiple types of data, you may select the last option, which allows column zero to contain any of the above types of data.  Care must be taken when mixing different data types in the same file, however, as data values for one type of  object may not be directly comparable to data values for a different object type.  In addition, names which are unambiguous when looking only for a gene, for example, may become ambiguous when the object can be either a gene, protein or compound. 

• 
Superimpose on previous display?: This item is available only when the Omics Viewer is already being used to display another dataset.  If this box is checked, then the new experi​ment view will be superimposed on the old one.  If this box is unchecked (the default), then the previous display will be cleared before the new data is shown. 

• 
Use data from: This item is available only when relative data is displayed. If the ratios themselves appear in a column in the data file, select single data column. If you want the ratios computed from columns of absolute data values, select ratio of 2 data columns.

• 
Are data values log values?: Check this box when the data values are logs, and leave it unchecked when the data values are linear values. Also check this box if the scale comprising the data is centered at zero (as opposed to 1), for example when displaying reaction flux data in which the sign of each datum indicates reaction direction.  If linear values are used, any zero or negative values in the data are ignored.

• 
Use expression data from data column: (when using a single column) Enter the column number containing the data to be viewed. The column containing the gene or protein names is considered to be column 0, so the data column numbering starts at 1. When displaying an animation, you should enter a list of columns, one on each line. Alternatively, you can enter a range —  for example, 1-10 —  to indicate that all columns in that range should be used.

• 
Compute relative data values as the ratio of data column __ / column __: (when using two columns) Enter the two column numbers containing the data to be compared. When dis​playing an animation, for the denominator you can specify either a single column, which will serve as the denominator for each numerator column, or you can specify a different denomi​nator column for each numerator column.

• 
Highlighting Color Scheme: Here, you can elect to use either the default color scheme or one you specify. 

o
Default color scheme with the maximum bin cutoff computed from the data: This option is the simplest to specify. It is useful when you do not know much about the range of val​ues in your data file or you want to see the color spectrum divided evenly across the full range of the data. Since this option will produce a different color scheme for every experiment, it is not useful for comparing figures generated across multiple experiments (though every time point in a single animation will use the same color scheme, of course).

o
Default color scheme with a specified maximum value bin cutoff: All values above the maximum cutoff (or below the corresponding minimum cutoff) are displayed in the same color, and the full color spectrum is divided evenly over the space between the maximum and minimum cutoffs. You can specify a maximum cutoff either by selecting one from the menu of commonly used possibilities or by typing in a value yourself. If you specify the same maximum cutoff for multiple experiments, all will be displayed using the same color scheme.

o
Specify color value cutoffs, assign colors automatically: To exercise more control over the display, you can provide the full list of cutoff values. This is useful, for example, if you are interested in grouping the data into only a few broad categories (e.g., 2x over/ under-expressed, 10x over/under-expressed) and are not interested in finer gradations. Enter a list of numbers, one per line (e.g., 10, 2, .5, .1).

o
Specify color value cutoffs, assign colors manually: This option gives you maximum control over the appearance of the resulting display. After providing the value cutoff numbers, click on Assign colors manually. A color selector box appears containing a scale computed from your supplied cutoff values, and a color spectrum. Assign colors to cutoff bins by clicking on the button corresponding to a bin and then clicking on the desired color. Click OK when done. 

o
Once you have created a color scheme, you can elect to save it to a file, so you can later retrieve and reuse it. Use the Save Color Scheme Parameters and Retrieve Saved Color Scheme Parameters buttons for these purposes.

There may be a pause while the data is read and processed. Once processing is complete, the xe "Overview"Overview is redrawn to show the experimental data, and a report window pops up containing a few statistics about the data and reporting any problem rows in the data file. Note that in whole genome microarray experiments, typically a large fraction of a given genome does not code for enzymes and therefore will not have any cor​responding reaction in the Overview. Statistics are provided both for the data set as a whole and for the subset of data shown painted onto the Overview. For an animation, a new window pops up containing the animation display, along with buttons to start, stop, and step through the animation. No reports are gener​ated for animations.

The Overview Key, in addition to the legend for mapping colors to data values, also includes a histogram showing the distribution of data values across the range, by color. The range is broken down into 50 sub​ranges. Histogram bars to the left of the central axis count the genes or other entities that actually appear in the Overview. Bars to the right of the central axis count the genes in the remainder of the data set (i.e.,those not in the Overview).

For gene expression experiments, to see exactly what expression values correspond to a colored reaction, middle-click on the reaction. The expression value is displayed in parentheses after each gene name in the listener window. This capability is particularly useful when a reaction is catalyzed by several isozymes, to see the expression level for each individual isozyme.

3.8.3    xe "pathway"Pathways

The Pathway/Genome Navigator produces automated drawings of biochemical pathways that are familiar to biochemists — the drawings that mimic those found in biochemistry textbooks. Because the power of computer graphics exceeds that of the printed page in several respects, the automated drawings provide more flexibility than those found in textbooks by allowing pathways to be expanded, contracted, and com​bined, and by adding additional information (such as regarding regulation) to pathway drawings.

Pathway drawings show a set of interconnected chemical reactions, the enzymes that catalyze those reac​tions, and the reacting substrates, as in Figure 3-4. 
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Figure 3-4:  E. coli pathway for threonine biosynthesis

Substrates are drawn in two ways. The compounds that are shared between subsequent reactions lie along the backbone of the pathway; they are called mains. Side compounds are drawn adjacent to the reaction arrow, with a curved arrow showing whether they are consumed or produced by the reaction. Enzyme names are drawn to the other side of the reaction arrow.

Pathway diagrams may include arrows showing regulatory interactions among the substrates and enzymes of a pathway. Each arrow leads from a substrate to a “+” or “–” sign adjacent to the enzyme whose activity the substrate modulates. The “+” or “–” indicates whether the effect on enzyme activity is positive or neg​ative. Some enzymes are modulated by additional compounds that are not substrates in the reaction. Click​ing on the “+” or “–”  displays a list of all compounds that activate and inhibit the enzyme, respectively. The display page for the enzyme  shows a more detailed breakdown of the activators and inhibitors into different classes (e.g., allosteric, competitive). Click on the enzyme name to see that page.

One type of relationship among pathways is shown within a pathway window under the headings “xe "superpathways; pathway: superpathways"Super-pathways” and “xe "subpathways; pathway: subpathways"Sub-pathways.” The E. coli database contains superpathways that are defined as con​nected aggregations of smaller pathways. For example, when the pathway for tryptophan biosynthesis is displayed, the Super-pathway subheading lists a superpathway called “trp+phe+tyr biosynthesis.” Clicking on the name of this superpathway navigates to it to show the synthesis of all three aromatic amino acids from chorismate.

All pathway drawings are computed automatically using xe "pathway-layout algorithms"pathway-layout algorithms devised by SRI’s Bio​informatics Research Group.  Although SRI continually improve these algorithms to produce more intui​tive and informative displays, be aware that the algorithms sometimes produce unintuitive results.

A somewhat novel aspect of the xe "pathway: display"pathway displays is the use of branching reaction arrows to represent complex relationships among reactions, as shown in Figure 3-5. 
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Figure 3-5: Examples of branching reaction arrows

In the figure, (a) depicts a situation in which one reaction converts two reactants A and B to the product C; two different reactions produce A and B, as shown by the in-pointing reactions. The situation in (g) involves two reactions that convert A to X, but only one of those reactions involves the reactant B. Five dif​ferent reactions transform A to B in situation (f).

Another aspect of our pathway displays that is not typical of textbook pathway drawings is the depiction of polymerization steps. A dashed line indicates that two compound names are in certain situations meant to represent the same species. For example, most textbooks depict saturated fatty acid elongation as a spiral, where each turn of the spiral adds two carbons to the backbone. Our representation shows the pathway as a cycle, using generic rather than specific names for the compounds involved. At the “beginning” of the cycle is acyl(n)-ACP, which undergoes several reactions producing acyl(n+2)-ACP. A dashed line is drawn between these two names to indicate that the (n+2) species becomes the (n) species for the next iter​ation of the cycle. We also use the dashed line when showing equivalence between a specific name for a compound (such as a starting or ending compound for a series of polymerization reactions) and the generic form. Using this scheme, we can compactly represent polymerization pathways as cycles of generic com​pounds, with specific compounds as inputs and/or outputs.

A small circle at the bottom of the xe "pathway: window"pathway window depicts the positions on the E. coli genomic map of the genes that encode the enzymes within the current pathway. When you move the mouse over a given gene, its name and map position are printed at the bottom of the display window, and all reactions in the pathway involving the gene’s enzyme are highlighted; clicking on the gene displays a window for that gene.  Also included is a graph showing which transcription factors affect transcription of the genes in the pathway.

3.8.3.1    xe "pathway mode commands; commands (Navigator): pathway mode"Pathway Commands

• 
Search by Name or Frame ID: (see “Direct Queries” in Section 3.7.1 for a general descrip​tion of the query by name command)

• 
Search by Substring (similar to other substring queries)

• 
Search by Class: You choose one or more pathways by first selecting one class from a menu of pathway classes, and then one or more pathways from a menu of all E. coli database path​ways in that class. 

• 
Search by Species: You query pathways according to the species in which they occur. You are first asked to select one or more species from a menu of all species defined in MetaCyc. Your can select one or more pathways from a menu of all pathways that are known to occur in those species. This command is enabled only for MetaCyc, since other PGDBs pertain to only a single species.

• 
Search by Substrates: Your can search for pathways according to the compounds that par​ticipate in their component reactions. As many as 20 compounds can be specified, and each compound can optionally be constrained to be an input to the entire pathway, a net product of the entire pathway, a reactant in any component reaction, or a product of any component reaction. Pathways are retrieved only if all specified criteria are met.

3.8.3.2    xe "command buttons; buttons: command"Command Buttons

• 
xe "More Detail/Less Detail button; buttons: More Detail/Less Detail"More Detail/Less Detail The Pathway/Genome Navigator can customize xe "pathway: drawings"pathway drawings in a variety of respects by filtering more or less information from the drawings. For example, EC numbers and gene names can be displayed or hidden, compound structures can be drawn, and pathways can be drawn as a skeletal overview that shows only those compounds at the exterior of the path​way, and at branch points. Although you can specify preferences (see “User Preferences” in Section 3.9.2) to provide fine control over pathway drawings, these command buttons provide a fast and easy way to increase or decrease the amount of detail shown in a pathway drawing. 

• 
Enzyme View  MetaCyc contains enzymes from many different organisms. By default, a pathway display in MetaCyc includes associated enzymes from any of the species for which the pathway is listed as having data avail​able. Alternatively, your can choose to display enzymes from only a single organism by selecting that organism for the Enzyme View. 

3.8.4    xe "reactions"Reactions

A reaction display shows the class(es) containing the reaction within the classification of reactions. It shows the one or more enzymes that catalyze the reaction, the gene(s) that codes for the enzymes, and the pathway that contains the reaction. The displays show the xe "EC number"EC number for the reaction, and the reaction equation. Note that there exists a one-to-one mapping between EC numbers and reactions, but not between EC numbers and enzymes [16], which is why we label reactions, and not enzymes, with the EC number. The standard change in Gibbs free energy of the reaction is listed when known.

The direction in which the reaction is drawn depends on the setting of a user preference.  The default behavior is for the reaction to be drawn in the direction in which the reaction is defined by the Enzyme Commission, or in the direction in which the reaction is stored in the database, for reactions that do not have assigned EC numbers.  The alternative behavior is for the reaction to be drawn in the direction in which it occurs in a pathway.

Links to the ENZYME, LIGAND, and WIT databases by EC number are shown.

Many of the preceding items are mouse sensitive. For example, if you click on the name of an enzyme, gene, substrate, or pathway, the Navigator displays that object.

3.8.4.1    xe "reaction mode commands; commands (Navigator): reaction mode"Reaction Commands

• 
Search by Name or Frame ID: (see “Direct Querires” in Section 3.7.1 for a general descrip​tion of the query by name command)  Reactions typically do not have names, although in some cases the name of the enzyme that catalyzes a reaction can be used to retrieve a reac​tion.  This command is most useful for calling up a specific reaction by its frame ID.

• 
Search by Substring
• 
Search By EC#: Allows you to call up a reaction by its EC number.

• 
Search By Class: You can choose one of the reaction classes defined by the Enzyme Nomenclature committee [16] from a menu of all such classes. You are presented with a menu of all reactions within that class; your selected reaction is displayed.

• 
Search by Pathway: You choose a pathway by first selecting from a menu of pathway classes, and then from a menu of all E. coli pathways in that class; then a third menu lists all reactions within that pathway. Your selected reaction is displayed.

• 
Search by Substrates: You specify one or more desired reactants and/or products, and you can choose from a list of reactions meeting these criteria. Because all reactions are consid​ered reversible for these purposes, there is no real distinction between reactants and products. However, if the “Constrain compounds to specified sides?” box is checked (the default), then, in order for a reaction to meet the criteria, compounds specified in the reactants section must all be on the same side of the reaction, and on the opposite side to all compounds spec​ified in the products section. If this box is unchecked, then there is no distinction between compounds specified as reactants and compounds specified as products—any reaction that contains all specified compounds as either reactants or products meets the criteria. 

3.8.5    xe "proteins"Proteins

Protein windows are fairly complicated because of the many-to-many relationship between enzymes and reactions (one enzyme can catalyze multiple reactions, and one reaction may be catalyzed by multiple enzymes). Furthermore, each xe "catalytic activity: of enzyme; enzyme: catalytic activity"catalytic activity of an enzyme may be influenced by different sets of cofac​tors, activators, and inhibitors. Also, many genes can code for subunits of a protein complex. The protein window is usually divided into sections to address these complexities. (See [10] for details of our represen​tations of enzymes and activators.)

The first section of the window lists general properties of the protein, such as synonyms, molecular weight, pI, cellular location, and subunit structure. If the protein is itself a substrate in one or more bio​chemical reactions, then those reactions are listed, sorted by the pathways in which they occur. If the E. coli database records that the protein is modified by some chemical group, a drawing of the protein cou​pled to the appropriate structure is shown.

Subsequent sections of the window describe each catalytic activity of the protein, if it is an enzyme (see Figures 3-6 and 3-7).

Each activity section lists a reaction catalyzed by the enzyme, and the enzyme name (and synonyms) for that activity. The xe "substrate specificity"substrate specificity of the enzyme is described in some cases by listing alternative com​pounds that the enzyme will accept for a specified substrate. The xe "cofactors"cofactor(s) and xe "prosthetic groups"prosthetic groups required by the enzyme are listed next (see Appendix   ), along with any known alternative com​pounds for a specified cofactor. xe "activators"Activators and xe "inhibitors"inhibitors of the enzyme are listed, qualified as to the mechanism of action, when known. In addition, this section indicates which of the listed activators and inhibitors are known to be of physiological relevance, as opposed to whether the effects are known purely because of in vitro studies.

The direction in which the reaction is drawn (i.e., A + B = C + D vs. C + D = A + B) depends on the setting of a user preference. The default behavior is for the reaction to be drawn in the direction in which the reac​tion is defined by the Enzyme Commission, or in the direction in which the reaction is stored in the data​base, for reactions that do not have assigned EC numbers. The alternative behavior is for the reaction to be drawn in the direction in which it occurs in a pathway, if known, or the direction in which the database indicates that the current enzyme tends to catalyze the reaction, if specified.

Additional sections of the window list each component (subunit) of the protein; when those components are polypeptides (as opposed to smaller enzymes) the gene encoding the polypeptide is shown. These sec​tions, and the first section, also list the molecular weight and pI of the subunits, and the protein complex, when known.

If the protein is a transcription factor, then the list of known transcription units (operons) controlled by the transcription unit is displayed in the protein window. See “Transcription Units” in section 3.8.9 for more infor​mation about interpreting displays of transcription units.
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Figure 3-6: Upper portion of protein display window for 2-dehydro-3-deoxyphosphoheptonate aldolase

[image: image10.wmf]
Figure 3-7: Lower portion of protein display window for 2-dehydro-3-deoxyphosphoheptonate aldolase

3.8.5.1    xe "protein mode commands; commands (Navigator): protein mode"Protein Commands

• 
Search By Name or Frame ID: (see “Direct Querires” in Section 3.7.1 for a general descrip​tion of the query by name command)

• 
Search By Substring: The program prompts you for one or more substrings, and then searches for proteins whose common name or synonyms contain all the substrings you entered.

• 
Search by Pathway: You choose a pathway by first selecting from a menu of pathway classes, and then from a menu of all E. coli database pathways in that class; then a third menu lists all enzymes within that pathway. The chosen enzyme is displayed.

• 
Search by SProt ID: You query proteins by their Swiss-Prot unique identifier. Usually PGDBs include the Swiss-Prot identifier of the form P123456.

• 
Search by Weight, pI: You query proteins by molecular weight and pI value.  Proteins are retrieved only if they match all specified criteria, but fields left blank are treated as unspeci​fied and are ignored.

• 
Search for Enzyme by Modulation: You query enzymes according to the activators, inhib​itors, or cofactors that modulate their activity. The dialog box for this command allows you to select the type of modulation (e.g., activation, inhibition), and then allows you to select the compound of interest.

With a button labeled Protein Sequence within the protein window, you can retrieve the amino-acid sequence of a polypeptide. The amino-acid sequence is computed on demand by translating the nucleotide sequence stored for each gene. This button appears multiple times within the protein window for a hetero​multimer, to allow you to retrieve sequences for each polypeptide chain within the multimer.

3.8.6    RNAs

RNA displays contain comments and citations for an RNA, a button to display the RNA sequence, and a link to the gene that codes for it.

3.8.6.1    RNA Commands

The RNA commands are all analogous to the commands by the same name in the other object type menus.

• 
Search by Name or Frame ID

• 
Search by Substring

• 
Search by Class

3.8.7    Genes

The gene window lists information for a gene such as its map position on its chromosome (in units of cen​tisomes, or hundredths of a chromosome), the functional class(es) assigned by Riley [13], and the direction of transcription. The gene product is listed (when known); when the product is an enzyme, the display shows the equation(s) of the reaction(s) catalyzed by the enzyme, and the pathways that contain those reactions.

The gene map position is mouse sensitive: clicking on this number creates a full-map display with enough child maps created to zoom in on the region of the chromosome containing the gene, to make the gene vis​ible.

If this gene is known to be interrupted (by a stop codon), the display prints a message to this effect.

The PGDBs for some organisms contain definitions of paralogous groupings of genes within the organism, which are usually computed using sequence-clustering methods. If a gene is known to be a member of one or more paralogous groups (genes containing multiple domains can be part of multiple groups), a message to this effect is printed, along with the name(s) of the paralogous group(s). Clicking on the name of a group  displays all genes in that group; the genes within that list are themselves clickable. The display of a paral​ogous gene group also shows the chromosomal locations of all genes within the group.

If the transcription unit (operon) containing the gene is known, it is displayed at the bottom of the gene window. See “Transcription Units” in Section 3.8.9  for more information about interpreting displays of tran​scription units.

In eukaryotic organisms, if the gene contains introns, a graphic shows their locations. Alternate splice forms are displayed. 

3.8.7.1    xe "gene mode commands; commands (Navigator): gene-mode"Gene Commands

• 
Search By Name or Frame ID: (see “Direct Queries”, section 3.7.1, for a general descrip​tion of the query by name command)

• 
Search By Substring: The program prompts you for one or more substrings, and then searches for genes whose common name or synonyms contain all the substrings you enter.

• 
Search by Class: You first choose a functional class from a menu of gene classes, and  then choose one or more genes from a list of all the genes in that class. 

Three buttons at the top of the gene window provide access to sequence information:

• 
Nucleotide Sequence retrieves the nucleotide sequence of the gene (coding region).

• 
Nucleotide Sequence Neighborhood retrieves an arbitrary nucleotide sequence with end​points specified by the user but defaulting to the gene boundaries.

• 
Protein Sequence retrieves the amino-acid sequence of the gene product. The amino-acid sequence is computed on demand by translating the nucleotide sequence stored for each gene. If the gene codes for multiple proteins (due to alternative splice forms), you must select which splice form to view. 

3.8.8    xe "compounds"Compounds

A compound display lists the common name and synonyms for a compound, plus its parent class or classes within the classification of compounds. It shows a compound’s two-dimensional structure, plus its empiri​cal formula, molecular weight, and pKA when known. The display lists all reactions in which the com​pound appears, sorted by the pathways that contain each reaction.

The display of some chemical structures within compound windows uses a concept called superatoms, which is a hierarchical structuring of chemical structures. For example, when displaying the structure for succinyl-CoA, the structure is initially displayed with the word "CoA" in place of the structure of the CoA moiety. If you click on the word CoA, however, the full structure of that moiety is displayed.

3.8.8.1    xe "compound mode commands; commands (Navigator): compound mode"Compound Commands

The compound menu can be used to query for small molecules such as pyruvate, D-glucose, and ATP.

• 
Search By Name or Frame ID: Usually several synonyms are recorded for each compound (and for other objects) — you can retrieve the compound by any of these known names (see “Direct Queries”, section 3.7.1, for a general description of the query-by-name command).

• 
Search By Substring: The program prompts you for one or more substrings, and then searches for compounds whose common name or synonyms contain all the substrings entered by the user.

• 
Search by SMILES substructure: You are prompted to enter a structure in SMILES for​mat, and can then choose one or more compounds from a menu of compounds containing the target structure (the Navigator online help system describes the SMILES format). 

• 
Search by Class: You choose one class from a menu showing all compound classifications, and then select one or more compounds from a menu of all compounds in the chosen class.

• 
Advanced Search: This command displays a dialog box that allows you to specify criteria for compound name, molecular weight, chemical formula, and substructure.  Compounds are retrieved if they match all the specified criteria.  Fields left blank are ignored.

3.8.9    Transcription Units

Some PGDBs contain information about the clustering of genes into transcription units, the transcription factors that control a transcription unit, and the location of promoters and transcription-factor binding sites within a transcription unit. We define a transcription unit as the set of genes, DNA control sites, and tran​scription factors associated with one promoter. When the expression of a set of genes is governed by more than one promoter, those genes are part of more than one transcription unit.

The display of a transcription unit shows the promoter, transcription-factor binding site(s), gene(s), and transcription terminator(s) associated with that transcription unit, when known. Directly below the pro​moter, the centisome-position of the promoter is printed, as is the direction of transcription ("+" for 5’ to 3’). The transcription-factor binding sites are displayed in two different colors (which depend on the cur​rent color preferences), by default those colors are red for inhibitory sites and green for sites that stimulate transcription.

The drawing of the transcription factor can be used for navigation within the PGDB. Clicking on a gene displays the gene window for that gene. Clicking on a transcription-factor binding site displays the protein window for the transcription factor, which lists all other transcription units controlled by that transcription factor. Clicking on the promoter produces a transcription-unit display window such as that shown in Figure 3-8, which displays detailed information about each site within the transcription unit, including its nucleotide position and sequence, evidence for the site, and literature citations for the site. Each site is numbered so as to unambiguously identify multiple sites for the same transcription factor.

Currently, there exists no menu for querying transcription units directly —  they can be found only by starting with transcription factors that control them, or genes that they contain.
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Figure 3-8: A transcription-unit display window

3.8.10    xe "genomic-map display"Genomic-Map Displays

Several methods exist for visualizing the maps of the replicons within an organism. These methods are based on map displays that allow you to view the distributions of genes on a map at multiple resolutions. Gene map positions are computed based on the start position of the coding region for that gene, in nucle​otides. For example, the physical-map positions for EcoCyc genes are computed from the Blattner Gen​Bank entry for the complete genomic sequence of E. coli [2]. The unit of measurement for map positions is the centisome (one percent of the length of the chromosome).

The transcription direction of a gene is indicated by drawing a horizontal line over the names of genes that are transcribed in the counterclockwise direction. The map displays employ semantic zooming, meaning that different semantic features are drawn at different levels of resolution. At high magnification, the map displays use arrows to show the extent of each ORF, and depict promoter and terminator positions for those promoters and terminators defined as objects within the PGDB.

3.8.10.1    The Linear Full-Map Display

One method of representing gene relationships is to draw all mapped genes at their chromosomal posi​tions. Select Chromosome->Browse Replicon->Full Linear to produce this display (see Figure 3-9). A given row in this drawing shows genes within the region of the chromosome opposite that row. Genes are ordered along each row from left to right according to increasing map position. The horizontal extent of the drawing is limited to allow zooming, by truncating each row. At the end of a row, “...”  indicates the existence of more genes that are not shown. If you click on the “...” the list of hidden genes is printed in the bottom pane. If you left-click on a gene present in a map display, the Navigator displays the information window for that gene.

You can zoom in on a region of the chromosome in several ways. Middle-clicking on any of the gene names shown in Figure 3-9 produces a higher-resolution drawing of the region of the xe "chromosome"chromosome cen​tered on that gene, such that one row in the first (parent) map now fills the entire screen in the child map. These high-resolution child maps can be generated to any desired level; you can also click on a gene in a child map to produce yet more resolution.

You can also zoom by left-clicking on the vertical line representing the chromosome. That operation always uses the same change in magnification from parent to child map. Control the change in magnifica​tion by specifying the top and bottom of the region of the chromosome that is to be expanded. Middle-click on the chromosome bar as the top of the desired region to start zooming, and then click at the bottom of the desired region to finish zooming.

A third method of navigation within the map is to click on the triangles drawn above each map segment. The triangles pointing to the left and right redraw the current map segment at slightly smaller and greater magnification, respectively. The triangles pointing up and down redraw the current map segment at posi​tions that are offset toward the beginning and end of the chromosome, respectively.

A fourth zooming method is to select the Chromosome->Zoom command. A pop-up menu offers several ways to specify where to zoom, such as by entering a centisome position or by typing a gene name. The Pathway/Genome Navigator produces as many levels of child maps as are necessary to show the requested gene.
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Figure 3-9: Full-map display that shows two levels

3.8.10.2    The xe "Circular Full-Map display"Circular Full-Map Display

The full map can be explored in circular form, as shown in Figure 3-10. Zoom in on a region by left-click​ing on the circle representing the chromosome, or by middle-clicking on a gene name. Magnified regions are linear and behave in the same manner as that described for the linear full-map display in the preceding section.
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Figure 3-10: Circular-map display

3.8.10.3    The xe "Linear Partial-Map display"Linear Partial-Map Display

With the linear partial map, you can examine map relationships among subsets of E. coli genes by begin​ning with a display of the chromosome with no genes present, and selectively adding genes to the window. The genes to be added can be selected by several criteria: by name (such as hisE), by matching a substring against all gene names (such as “his”), as members of one of the classes of all E. coli genes defined by Riley [13] (the classification is based on the function of the gene products, such as membrane components or tRNAs), or the set of genes coding for enzymes in a chosen biochemical pathway.

You can consecutively add sets of genes according to the above criteria, and you can undo previous add operations in reverse order. For example, you can add all genes in the biosynthetic pathways for tryp​tophan, tyrosine, and phenylalanine, and then add all genes coding for membrane proteins. The zoom capabilities described in conjunction with the full map also work for the partial map.

3.8.10.4    chromosome commands

• 
Select Chromosome/Replicon: For organisms with multiple chromosomes or plasmids, you can select the current chromosome or plasmid for display. Clicking on a chromosome within an organism-summary page also selects that chromosome as the current chromosome.

• 
Show Sequence: Retrieves the nucleic-acid sequence of a region of the current chromosome, or the reverse-complement of a specified region.

• 
Browse Replicon
o
Full Linear: Displays a linear diagram of a chromosome or plasmid.

o
Partial Linear: Displays an empty partial linear map of a chromosome or plasmid.  Use the Add command to add genes to this map.

o
Circular: Displays a circular diagram of a chromosome or plasmid.

• 
Add: Adds genes to a partial map. You can specify the genes to be added in several ways, which are selected from a pop-up menu:

o
Locus by name: Name one gene to be added.

o
Loci containing substring: Add all genes whose name (common name or synonyms) contains a substring that you type.

o
Loci within gene classes: Select one or more functional classes of E. coli genes from a pop-up menu; all genes within that class are added.

o
Loci within pathway: Selects a pathway from a menu of all pathways. All genes that code for enzymes that catalyze a reaction in the selected pathway are added. 

• 
Undo: Removes the most recently added set of genes from the partial map.

• 
Zoom: You can zoom in on a region of the currently displayed chromosome by clicking on a gene where zooming is to be centered, or entering a gene name, or entering the centisome position where zooming is to be centered. Zooming creates a new child map.

• 
Zoom Again: Adds a new child map at higher resolution, centered at the same position as the last zoom.

3.9    Miscellaneous Commands and Tools

Various tools not specific to any type of biological object are available from the File or Tools menu or as buttons in the main window.

3.9.1    xe "history: commands; commands (Navigator): history"History

The history list tracks the objects you have recently displayed. You can move forward or backward in this list one step at a time, or select a specific object from the list.  See “ History List” in section 3.7.3, for more details.

3.9.2    Answer-List

When a query such as a substring search returns multiple answers, the first answer is displayed and the rest are placed on the Answer List. Several commands allow you to manipulate the xe "Answer List"Answer List.

• 
Next Answer (button) displays the next object on the Answer List

• 
Answer List (button) displays an object that you select from a menu of Answer List items.

• 
Tools->Answer List->Show on Console prints the contents of the Answer List in the origi​nal console window in which the Pathway Tools were invoked.

3.9.3    xe "Clone Window; commands (Navigator): Clone Window"Clone

It is sometimes useful to capture one or more object displays for future reference, such as to allow infor​mation about two different objects to be visually compared (see “Parallel Comparison” in section 3.10.3). The Clone button causes a new window to be created as a copy of an existing pane in the main display window (the command prompts you to click on the pane to clone, if more than one pane is visible). You can navigate in the cloned window as usual, so that several tracks of inquiry may be pursued at the same time.

3.9.4    xe "Fix Window; commands (Navigator): Fix Window"Fix and xe "Unfix Window; commands (Navigator): Unfix Window"Unfix

The Clone command provides one way of looking at displays of more than one object at a time. A second approach is to change your preferences so that the Navigator has more than one display pane active at a time (see “Pane Layout” in section 3.9.9.1). When multiple panes are active, the Navigator normally displays the next object in the least recently used pane. However, you can use the Fix button to fix a given display pane so that it is not overwritten. Fix asks you to click on the window that you want to fix, if more than one display pane is active in the Pathway/Genome Navigator.  Similarly, the Unfix button prompts you to click in the window that you no longer wish to remain fixed.

If you fix all panes, the Navigator displays the next object in a pop-up window (it reuses an existing pop-up window, if one already exists). This approach is useful if you need to see object displays in large win​dows.

3.9.5    Print

 Select menu File->Print to print any Pathway/Genome Navigator pane to a PostScript file

3.9.6    Help

 The Help menu contains a small number of help topics for the Pathway/Genome Navigator.

3.9.7    Software Patches

Selecting menu item Tools->Instant Patch->Download and Activate All Patches downloads and applies the latest Pathway Tools software patches to both the Pathway Tools installation and the current running Pathway Tools application. There is usually no need to restart the Pathway Tools application to incorporate patches.

3.9.8    Exiting Pathway Tools

• 
xe "Exit (Navigator command); commands (Navigator): Exit"Selecting menu File->Exit terminates the Pathway/Genome Navigator. If the Navigator is the only part of Pathway Tools you were running, then selecting this menu item also exits Pathway Tools.

3.9.9    xe "user preferences; preferences: user"User Preferences

You can customize the displays produced by the Pathway/Genome Navigator. Commands to change user preferences are found in the Tools->xe "Preferences menu; menus: Preferences"Preferences menu. If you change preferences during a session, then before you exit the session you will be asked if the changes should be saved. Preferences are saved in the file.xe "ecocyc-prefs file"ecocyc-prefs in your home directory. That file is loaded when the Pathway/Genome Navigator starts, so the program is automatically configured to your own preferences.

The options within the preferences menu are as follows.

3.9.9.1    xe "layout"Pane Layout

One to four display panes can be present simultaneously. These panes are arranged on the screen in tiled fashion, so the size of each pane depends on the total number of panes present. You can choose the number of panes from the Pane xe "Layout menu; menus: Layout"Layout menu. Note that some object types look better displayed on panes of cer​tain sizes. For example, the complex graphical displays of pathways and genetic maps generally look bet​ter when only one or two display panes are present, so that the display can cover the entire screen width. Simple or primarily textual displays such as for genes or compounds (especially those with simple struc​tures) do not suffer from being displayed on a smaller pane, and it might be advantageous to be able to dis​play several objects at a time.

3.9.9.2    xe "color"Color

Several color palettes, which assign specific colors to the window background and each type of object, have been predefined and are named in the xe "Color menu; menus: Color"Colors menu. Because different monitors show colors differ​ently, you are encouraged to try out several of these color combinations until you find one you like. Note that for monochrome monitors, only two color palettes are available: Black on White and White on Black. On color monitors, palettes are available with black, white, gray, or blue backgrounds.

3.9.9.3    Text Font Size

To select a font size for the Navigator display panes, go to the Tools->Preferences->Text Font Size menu and click on the preferred size. Text embedded in graphics is controlled not here but rather in the object displays listed below .

3.9.9.4    Citation Reference Style

You can use this preference to choose whether references in page displays show up in numeric form (e.g. [1]), in short-hand mnemonic form (e.g. [Smith95]), or in full or abbreviated APA style (e.g. [Smith & Jones, 1995]).

3.9.9.5    Overview Display

You can apply a scale factor to alter the size of the Overview. Enter an integer that will be treated as a per​centage —  a value of 100 is the default scale factor.

3.9.9.6    xe "Pathway Window menu; menus: Pathway Window"Pathway Display

This menu determines what elements are included in pathway diagrams, and how those elements are drawn. The options None, Most, and All for structure-drawing preferences are the same as for reaction windows, although for pathways the default is not to show structures. Most of the preference options should be self-explanatory.

The preferences available for pathway windows are

• 
Show structures for main compounds: Main compounds are those that run along the main backbone of the pathway.

• 
Show names when structures are shown: If No and compound structures are drawn, the compound names will be omitted.

• 
Show side compounds: Side compounds are those that do not run along the main backbone of the pathway. They can be omitted from the display completely, if only a general overview of the pathway is desired.

• 
Show side structures: Whether or not structures are drawn for side compounds.

• 
Show enzyme names: Like side compounds, enzyme names can be either omitted or included in the pathway diagram.

• 
Font size for mains: Five logical font sizes are available. Smaller font sizes mean that path​ways can be displayed more compactly, whereas larger font sizes may be easier to read (espe​cially, for example, when the display is to be converted to a slide or transparency).

• 
Font size for sides and enzymes: Side compounds and enzymes can be displayed using either the same size font as for main compounds, or one size smaller.

• 
Reaction arrow emphasis: Two options are available for reaction arrows. The reversibility option draws double arrows to indicate that a particular reaction is reversible (a reaction is assumed to be reversible unless it is known to be irreversible). The pathway-flow-direction option draws single arrows for each reaction, in a direction to indicate the typical flow of the pathway. The former option provides more information, but the latter option may be clearer to read, particularly in complex branching pathways.

• 
Layout for linear pathways: Linear pathways are laid out in Snake fashion by default, to enable as much of the pathway as possible to fit on the viewport. The other options are to draw the pathways in a single horizontal or vertical line. Displays of branched or cyclic path​ways cannot be customized in this fashion.

• 
Show pathway graph only, without title or text: When this option is selected, only the pathway graph itself is displayed. This might be useful, for example, when preparing figures for publication or slides.

3.9.9.7    xe "reaction window; windows: reaction"Reaction Display

Preferences in this menu control how the reaction participants are drawn within the reaction window. Three possible layouts can be used for reactant and product compounds: drawing all participants in a sin​gle horizontal line, drawing the reactants in a vertical row to the left and the products in a vertical row to the right, or drawing the reactants in a horizontal row on top and the products in a horizontal row under​neath. By default, the layout is chosen automatically to ensure that the reaction will fit within the window viewport and still meet the default size constraints. However, you can choose a particular layout for con​stant use, in addition to choosing the various scaling constraints as for compounds.

By default, most compounds are drawn with structures. However, there is a set of compounds for which we choose not to show structures. These are typically common cofactors such as ATP and NADH, whose structures, if drawn, are likely to distract the user from the principal transformation occurring. You can change this default to show either all or no structures. Be aware that structures for some compounds are not currently available in MetaCyc and other PGDBs.

You can add to and remove from the set of compounds for which structure drawing is suppressed under the Most option by right-clicking on the compound in question. A menu of commands appears if the drawing of a compound structure has not been suppressed. The menu contains the item Show name only for this compound, which turns off structure drawing for the compound on this and future reaction displays. If structure drawing is currently suppressed for the compound, the menu item reads Show structure for this compound.

The preferences available for reaction windows are

• 
Scale: Scale can be either variable or fixed, as for compounds.

• 
For variable scale:

o
Minimum scale factor: The minimum allowable average bond length in pixels. A large minimum scale factor means that some reactions will not fit entirely within the viewport. Small minimum scale factors may make compound structures difficult to read.

o
Maximum scale factor: The maximum allowable average bond length in pixels.

• 
For fixed scale:

o
Scale factor: The average bond length in pixels when structures are to be drawn at a fixed scale.

• 
Layout: Four options are presented for layout of reaction equations, as described above. The Variable option allows the Navigator to automatically choose the best of the other three options.

• 
Show structures: This determines whether structures are drawn for compounds in the reac​tion equation. The options are Most, None, and All and are described above.

• 
Display reaction direction: Reactions can be drawn either in the direction specified by the Enzyme Nomenclature Commission (option enzyme nomenclature, the default), or in the direction in which the reaction appears in metabolic pathways (option direction in path​way(s)). If a particular reaction appears in different directions in different pathways, then the reaction is always displayed in the Enzyme Nomenclature direction.

3.9.9.8    xe "compound windows; windows: compound"Compound Window

User preferences control how compound windows, and primarily xe "compound structures"compound structures, are drawn. By default, compound structures are automatically scaled to be as large as possible and still fit entirely within the designated window, while remaining within a predefined size range. The font size used for the atoms is selected to look appropriate in comparison to the average bond length. At times, however, this might not be the case. For example, some machines do not have large font sizes available to them. Atoms drawn in the smaller fonts may look silly against the long bonds produced by the scaling algorithm. In this case, you might want to decrease the maximum allowable scale factor to ensure that all compounds are drawn in pro​portion. In another situation, you might want all compound structures to be drawn to the same scale so that, for example, hardcopy outputs of different compounds are consistent. In this case, you can switch from a variable to a fixed scale, and assign a suitable scale factor.

The preferences available for compound windows are

• 
Scale: Scale can be either variable or fixed, as described above.

• 
For variable scale:

o
Minimum scale factor: The minimum allowable average bond length in pixels. A large minimum scale factor means that some larger compound structures will not fit entirely within the viewport. Small minimum scale factors may make large compound structures difficult to read.

o
Maximum scale factor: The maximum allowable average bond length in pixels. Large maximum scale factors may suffer from the font size problem mentioned above.

• 
For fixed scale:

o
Scale factor: The average bond length in pixels when structures are to be drawn at a fixed scale.

• 
Verbose mode: Some compound information is intended only for developers and is not nor​mally displayed in compound windows. When this preference is set to Yes, however, all slots in a compound frame appear in the compound window.

3.9.9.9    xe "History/Answer List dialog box; dialog box: History/Answer List"History and Answer Lists
This dialog box allows you to alter the length of the history list. A smaller history list means that fewer items are stored, but the list is faster to cycle through. To change the length of the history list, click on the number currently displayed. It disappears, and you can enter a new number. If you change your mind and do not want to enter a new number, simply press return, and the previous value will reappear.

Another part of the History/Answer List dialog box allows you to control what happens when the Next Answer command is invoked. By default, each time Next Answer is invoked, new objects are displayed in all the unfixed display panes in the main window. However, you can change the default so that only one new object at a time is displayed.

3.9.9.10    xe "user preferences: reverting and saving; preferences: user, reverting and saving"Reverting and Saving User Preferences

Select  Tools->Preferences->Restore Saved Preferences to revert to the set of preferences previously stored in your.ecocyc-prefs file. Unless you have saved a new set of preferences during the current session, these were the preferences in effect when you started your session.

Select  xe "user preferences: Save; preferences: user, Save"Tools->Preferences->Save to save the current set of preferences to your .ecocyc-prefs file. These preferences will be loaded in your next session. Note that if you change preferences but do not save them, or if you change them again after saving them, then upon exiting you are automatically asked if you want to save the new preferences.

Select  xe "user preferences: Revert to default; preferences: user, Revert to default"Tools->Preferences->Restore Defaults to revert to the “factory settings” for the preferences.

3.10    xe "comparative operations"Comparative Operations

Information is stored in databases using a consistent format compatible with the Pathway/Genome Naviga​tor. Consequently, the Pathway/Genome Navigator can be used not only to navigate the information con​tained within a given database but to also compare the information contained in two or more databases; that is, the Navigator supports xe "comparative analyses: pathways and genomes"comparative analyses of the pathways and genomes of two or more data​bases. 

This section is relevant to you only if you currently have access to more than one database. For the pur​poses of demonstrating some of the available comparative operations, we provide some examples centered around a number of PGDBs, some of which may not be included in your distribution of the Pathway Tools and databases. If this is the case, simply replace one or more of the named databases with one or more of your own databases (e.g., proprietary databases developed using the PathoLogic Pathway Predictor).

Two distinct types of comparative analysis are supported:

• 
Global comparisons of the metabolic-networks of a user-defined set of databases

• 
Comparisons of specific instances of biological objects across two or more databases 

Global analyses are available from within the Overview Mode of the Current Organism with the results painted onto the Overview diagram for this organism. Comparisons of specific instances of biological objects across databases are available from within each of the seven command modes.

3.10.1    xe "global comparative analyses; comparative analyses: global"Global Comparative Analyses

The metabolic overview of the current organism can be used to highlight all reactions of the Overview shared or not shared with any or all members of a user-specified group of organism databases. This high​lighting allows you to compare the metabolic overview of the current organism against those of one or more other organisms. For this reason, these comparison are referred to as global comparative analyses. If your interest lies in developing antimicrobial drugs, these kinds of analyses provide a convenient means of computationally predicting the spectrum (i.e., across the organisms for which databases are provided) of an antimicrobial agent designed to target a specific metabolic enzyme/reaction(s).

To perform such an analysis

• 
Select an organism as the current organism and invoke Overview->Show Overview.
• 
Remove any past highlighting using the Overview->Highlight->Clear All command.

• 
Invoke Overview->Highlight->Species Comparison.

• 
Specify the nature of the comparison using the Shared/Not-Shared and Any/All options.

• 
Select a set of organisms for comparison. 

To select the organism to be compared against other selected organisms (the reference organism), make it the current organism.  After you display the overview and invoke the Overview->Highlight->Species Comparison command, the xe "Species Comparison dialog box; dialog box: Species Comparison"Species Comparison Dialog box (see Figure 3-11) will appear. 
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Figure 3-11: Global comparative analysis

This dialog box is used to select both the nature of the comparison and the organisms to be compared against the Current Organism. Specify the type of comparison to be performed by selecting the Shared or Not-Shared option. By default the Shared function will be used. This option defines the nature of reac​tions highlighted, that is, those shared among or not shared among the Current Organism and any (one or more) or all of the members of a user-defined set of organisms. Next, specify how the comparison is to be performed by selecting the Any or All option. Selecting Any means that reactions shared between the ref​erence organism and any one or more or all of the organisms in the user-specified list will be highlighted. Selecting All imposes a stricter criterion; only those reactions shared between the reference organism and all listed organisms are highlighted. The final step is to define the set of databases to be used for compari​son. Go to the box within the Species Comparison Dialog box that lists the available databases (except the reference organism). Select one or more of these databases by left-clicking on the Select All button. Alternatively, you can select a subset of this list. To create such a subset, select each desired database by left-clicking on its name, which will then become shaded.   To deselect a database, left-click once on its shaded name (it will become unshaded). To deselect all selected organisms, left-click on the Deselect All button. Once a set of one or more organisms has been selected, left-click on the OK button.

Depending on the number of databases selected, the exact nature of the comparison, and the type of machine on which you are running, the comparison may take up to several minutes. The clock face icon indicates that the analysis is under way. Once the analysis is finished, the results are painted onto the met​abolic overview of the reference organism. All reactions that satisfy the specified conditions are high​lighted in a given color and the number of highlighted reactions is listed in the LISP listener pane.

Additional xe "species comparisons"species comparisons can be performed with the results superimposed upon the existing high​lighting using a different color. Any number of comparisons can be superimposed. Specific colors are used for successive comparisons. When a Gray/Black Background is selected in the User Preferences (see “User Preferences” in section 3.9.9) the colors yellow, green, can, orange, magenta, Navaho-white, red, pur​ple, spring-green, and deep-pink are used in succession. Alternatively, with a White Background selected in the User Preferences (see “User Preferences” in section 3.9.9) the colors green, orange, magenta, tur​quoise, hot-pink, blue-violet, light-sky-blue, red, and fire-brick are used. Once all colors have been used, the Navigator recycles through the given list of colors in the order stated above. Any overlap between sets of highlighted reactions is shown in white. To identify the specific combination of overlapped colors that resulted in a given reaction being highlighted white, move the mouse cursor over the reaction; the stoichi​ometric equation for this reaction and the name(s) of overview pathway(s) in which it occurs will appear in the bottom pane. A set of colored bars appears to the left of the reaction equation. These denote the over​lapped highlight colors for this reaction. Invoking the Overview->Show Key command brings up the gen​eral key for the Metabolic Overview. At the bottom of this is a specific key for the highlight colors painted onto the Overview. For each color, the nature of the corresponding analysis is summarized.

The key is updated dynamically with successive highlights. However, if you undo the previous highlight (see below) the corresponding key entry is removed and is not be recovered should you choose to Redo the last unhighlight (see below). The Overview->Highlight->Undo command removes the highlighting intro​duced by the last species comparison performed. It can be used consecutively to remove superimposed highlighting colors. The Overview->Highlight->Redo command rehighlights only the last set of reactions unhighlighted. However, as noted above, the color key is not updated to reflect this. The Overview->Highlight->Clear All command removes existing highlighting.

You can unhighlight the results of a previous comparison before your perform another one. Alternatively, you can clear the overview of all previous highlightings by using the Clear All command. Use multiple highlighting to perform complex comparative analyses such as those relevant to designing a desired spec​trum for an antimicrobial drug. For example, you could identify all reactions that are shared by all mem​bers of a target set of organisms (e.g., those that commonly cause a specific infectious disease) but that are not predicted to occur in another set of organisms (e.g., members of normal gut flora).

3.10.2    xe "sequential comparison"Sequential Comparison

When browsing through a PGDB, you might find that more detailed information about a given biological object may be available from the E. coli database than from other PGDBs. This occurs because the infor​mation content of the other PGDBs is largely computationally derived, while that for E. coli is experimen​tally derived. It is therefore sometimes informative to navigate from an object display to the comparable EcoCyc display. It should not be assumed a priori that objects with identical names in the computationally derived and the E. coli databases are functionally identical since, for example, “equivalent” enzymes may differ across organisms in terms of their regulation and subunit composition. However, unless reliable experimental data is available about the object in the computationally derived database (consult the pri​mary literature to find such data), the E. coli homolog can serve as a working “model” for the computa​tionally derived object (since it will generally contain more information).

3.10.2.1    Current Organism-Dependent Comparisons

One method that may be used to navigate from a computationally derived database object display to that for the E. coli homolog involves changing the current organism from one of the computationally derived databases to E. coli and then using the command mode query facilities to find the relevant homolog (assuming one exists). When you search, you can find homologs by using substrings of enzyme and path​way names. Be cautious when using this approach to find E. coli gene homologs because, in general, a consistent vocabulary has not been used for naming genes across organisms. The primary disadvantage of this approach is that it may require numerous mouse operations and by the time you navigate to the rele​vant E. coli display, you could have forgotten pertinent details of the other display. This can be amelio​rated by either printing the individual window displays or making notes about each display for subsequent comparison. Alternatively, as outlined below, you can set display command options so that relevant object displays can be placed side by side for direct visual comparison.

3.10.2.2    Current Organism-Independent Comparisons

A second method for navigating from a computationally derived database object display to that for an E. coli homolog requires the use of pop-up windows. This option is available from compound, reaction, protein, and gene display windows. Specifically, when viewing a display for the given object within a spe​cific organism, the comparable object, if present in another organism, can be accessed by first moving the mouse cursor over the object name in the display title (a rectangle should appear around it) and right-click​ing the mouse button. This brings up a pop-up menu from which the xe "Show in Organism; commands (Navigator): Show in Organism"Show in Organism option can be selected to display a list of available organism databases. Selecting a given database results in the display window being replaced with a comparable display for the same object in the selected database (if the object does not exist in the selected database, then the following error message appears in the bottom pane (the listener pane): “Object does not exist in selected organism”). By alternately using the Back and Forward commands, you can compare the entries for the given object in the two databases. To view the same entry in a third database, go to the display window, repeat the above procedures, and select the name of a third database. Now use the Back and Forward commands to scroll between three distinct displays of the same object across the three selected databases. The above operations can be con​tinued until displays of the given object in any number of available organisms have been accessed. Note that none of these operations changes the Current Organism. You should be cognizant of the nature of the Current Organism since all queries issued through the command menu operate upon the corresponding database.

Alternatively, from a given display window (e.g., Overview and pathway displays), you can directly navi​gate from a component of the display (e.g., a reaction or compound) to a display of that component as present in another user-specified database. For example, set the current organism to Mycobacterium tuber​culosis. Using the Pathway->Search by Substring command, bring up a display of the glycolytic path​way in the main display window, and then right-click on any compound in the pathway to bring up a menu of options. Select the Show in Organism option by either left- or right-clicking on it to bring up the Choose species menu, which lists available databases. Left-click on the name of the organism of interest, for example, E. coli. This brings up a display window for the compound in the specified database (assum​ing such an object exists). If this compound information cannot be found, then an error message to that effect appears in the bottom pane (listener pane): “Object does not exist in selected organism KB”. By using a comparable set of commands, you can also select a reaction, enzyme, or gene from a pathway display and navigate directly to a display of that object in a specified database (if present).

A comparable set of operations can be used on Overview displays. For example, select Mycobacterium tuberculosis as the current organism and use Overview->Show Overview to bring up the Overview Dis​play for this organism. Move the mouse cursor over a compound in the overview display. A left-click will take you to the display window for this compound. Alternatively, a right-click will bring up a menu the last two options of which are relevant to species comparison:

• 
Display compound information for selected species

• 
Display pathway information for selected species. 

Selecting either one of these options causes the Choose species menu to appear, listing names of available databases. Selecting a database brings up the compound/pathway display for the selected database. This operation does not change the nature of the current organism. Use the Back command to return to the met​abolic overview for the current organism.

Alternatively, the mouse cursor may be moved over a reaction in the database for the metabolic overview. A left-click on the reaction will take you to the display window for this reaction in the current organism. Alternatively, a right-click on the reaction in the overview will bring up a menu, the last two options of which are relevant to species comparison: 

• 
Display reaction information for selected species

• 
Display pathway information for selected species. 

Selection of either of these options brings up the Choose species menu, which lists available databases. Selecting a given database brings up the relevant reaction/pathway display. Use the Back command to return to the metabolic overview.

3.10.3    xe "parallel comparison"Parallel Comparison

The operations described above present sequential displays of specific instances of particular objects, for example, a particular pathway, as described in two or more distinct databases. However, user preferences can be set to support concurrent display of multiple display windows such that you can view equivalent instances of an object across two or more organisms; that is, each window provides a display for each organism.

For example, to compare the alanine biosynthesis pathways of E. coli and Hm. influenzae, select Tools->Preferences->Pane Layout->2 panes.  Set the Current Organism to E. coli and then invoke Pathway->Search by Name or Frame ID. This brings up the Dialog Box into which you should type alanine biosynthesis-I. A display for this pathway appears in the top window. Click on the Fix command button and then click on the top window. Move the cursor over the words “alanine biosynthesis-I” as they appear in the display title and right-click the mouse button. This brings up a pop-up menu from which you should select the Show in Organism option to bring up a list of available databases. Selecting one of these —  for example, H.influenzae —  results in a display of the alanine biosynthesis pathway for the selected database in the main display of the bottom window. You can now visually compare the pathway across the two organisms (see Figure 3-12). 
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Figure 3-12: Global comparative analysis

By using a comparable set of commands, you can also compare other objects. For example, Figure 3-13 shows a comparison of the genomic maps of E. coli and H.influenzae.
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Figure 3-13: Global comparative analysis

The user preferences support incorporation of as many as four distinct windows in the display layout. By consecutive application of the Fix command, you can visually compare four instances of a given class. Note, however, that two or more metabolic overviews cannot be displayed using this approach.

To compare two metabolic-overview diagrams, use the xe "Clone Window; commands (Navigator): Clone Window"Clone command (see “Clone”, section 3.9.3). You can also use this option to compare instances of other classes, for example, pathways. Use the Clone com​mand to duplicate any window display; you can clone any number of window displays. Cloned windows do not support the full range of menu options in the full Navigator window, but they do support history commands and clicking on objects within the window, such as for hypertext navigation or for editing. However, you do not have access to any of the command menu options. The history for the clone window is cleared at the time of cloning, but as you navigate between related displays, a local history is constructed for this window. Move back and forth between these displays by using the move back and forth in history commands available within the clone window.

To use the Clone command to compare two metabolic overviews, set the Current Organism to an organ​ism of interest (e.g., Hb. pylori) and invoke Overview->Show Overview. The overview for this organism appears in the main display window. Click on the xe "Clone Window; commands (Navigator): Clone Window"Clone button to bring up the overview display window (see Figure 3-14).
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Figure 3-14: A clone window showing the Hb. pylori metabolic overview

Change the current organism to that of the organism to be compared and again invoke Overview->Show Overview. The metabolic overview for the second organism appears in the main display window. Now position the clone and main display windows so that the respective overviews can be visually compared.

4

Database Sharing

4.1    Publishing your databases

The process of publishing a database involves three steps: 

1.
The directories and files that make up the database are packaged and compressed into a sin​gle archive file.

2.
The packaged file is moved to an FTP file server that allows anonymous access for retrieval of stored files.

3.
The location of the packaged database, and essential information about its contents, is sent to the central registry server, from which it is visible to Pathway Tools users across the entire Internet.

Fetching of shared databases is done through a standard FTP server. If you publish one of your databases, you do not need to have Pathway Tools running in order for others to retrieve and install the database.

4.1.1    Details of what happens during each step:

1.
Packaging the database

The “tar” program is used to package the entire directory tree for the database into a single file, which is then compressed using the “gzip” program. The compressed file is then moved to the standard directory for temporary files (this is different for Windows and for Unix/ Linux—see below for details).

2.
Moving the archive to an FTP server

If your site configuration allows it, FTP (File Transfer Protocol) is used to copy the packaged database from the standard temporary directory on your system, to the server that you speci​fied in the Database Sharing preferences dialog. Note: this step does not depend on an exter​nal “ftp” program, but runs entirely within Pathway Tools. Once the file has been copied to the FTP server, the temporary file is deleted.

3.
 Registering

Pathway Tools contacts the central registry server over the Internet, and transfers informa​tion about your database that will allow others to browse and download it. The information stored includes:

• 
Database authors

• 
The species name and strain

• 
Genome

• 
Version

• 
Copyright

• 
A comment for the entire database

• 
Contact email address

• 
The URL of a license agreement for the database, if there is one

We have made every effort to automate the process of sharing databases, but for security reasons, anony​mous FTP servers are usually organized in a way that requires files that are copied to the server to be man​ually moved to a different directory for subsequent public retrieval. Our user interface allows you to perform each of the three required steps separately, in case a manual step is required between the packag​

ing/storing and registering steps. Because of the wide range of platforms and network configurations in general use, we can provide only general instructions for copying files to your FTP server manually, if necessary. The details of this process are dependent on the setup of your site—please consult your local system administrator for more information on how to do this at your location.

4.1.2    Preliminary step: setting preferences

Before actually beginning the processing of your databases for publishing, you need to fill in the Database Sharing preferences dialog. This is available from the main command menu via Preferences -> Database Sharing. The preferences setting dialog is shown in Figure 1. Note that these preferences are needed only for publishing your own databases, not for fetching shared databases from other sites.

The first time that you invoke the preference dialog for database sharing, an initial dialog pops up, allow​ing you to enter some basic properties of the way your site is set up. The user interface for PGDB publish​ing is customized to provide the simplest possible user interface, based on the constraints of your site’s configuration.

Unless there are major changes to the way your site is administered, you should not need to run this initial setup more than once. Nevertheless, the main preferences dialog has a button that displays this dialog again, so that it is always possible to go back and change your answers to the questions in the initial dialog.

As shown in the figure, the initial dialog contains a good deal of explanatory text, and is intended to be self-documenting.

Once the two questions on the initial setup dialog have been answered, the main preferences dialog is dis​played. It contains the following items:

• 
Enable PGDB sharing functionality: This checkbox can be used to completely disable PGDB sharing, if desired. In general, enabling PGDB sharing should have little effect on the operation of Pathway Tools. The one exception to this is that displaying the summary page for all organisms queries the server for databases that were installed via the database sharing facility, to see if a newer version is available. If the server does not respond within a few sec​onds, the query is simply skipped, so the summary page should display fairly quickly even if the servers for these databases are completely unavailable. If you notice a delay in displaying the summary page, temporarily disabling PGDB sharing may eliminate the delay, and will have no effect on the functioning of any of your databases.

• 
Rerun initial setup: Pushing this button will cause the initial setup dialog to appear, and will allow you to change your answers to the basic setup questions.

The rest of the preferences dialog is divided into two parts. The first set of fields contain information needed for storing files on an FTP server. If you answered “no” to the question about using FTP for storing files in the initial settings dialog, this section will not appear at all.

FTP server to which files will be uploaded: Enter the Internet name or address for the FTP server to which you will connect for storing your archived databases, just as you would enter it for manually starting an FTP session.

Username for storing to the FTP server above: This is the username that will be used to log in to the FTP server. For security reasons, we do not store passwords between sessions. A pop-up dialog for entering the password will appear the first time that you store a database in each Pathway Tools session.

Directory to which archive files will be copied: Enter the full pathname for the directory. This is what you would give for a “cd” command, when using FTP to transfer files by hand. In most installations, this will not be the same directory from which remote users will retrieve archived PGDBs.

The second set of fields contain information that will be sent to the central registry server, in order for users at other sites to connect and retrieve your databases. These values must be filled in before contacting the registry server for the final step in publishing your PGDB, regardless of how you copy files to the FTP server prior to making them available for retrieval.

FTP server users from which archived databases will be retrieved: This should be the Internet name or address of the server, as it would be entered by a user at another site on the Internet. Note that this may not be the same as the server name or address that you entered above for storing files, even though it may be the same computer.

Directory from which archived database will be retrieved: This should be a full pathname, as described above. In most instances, this will simply be “pub”, since by convention that is the standard directory for anonymous FTP access.

Once you have filled in all of the fields in the preferences dialog and saved your preferences, you can con​tinue with the process of publishing local databases.

A NOTE ON LICENSING: The first time that you use any portion of the database sharing facility, whether for publishing your own databases or for retrieving databases from other sites, the click-through license agreement for the Pathway Tools Registry will appear. Please read carefully the text of the license agreement. If you are in agreement with all terms of the license agreement, click “I ACCEPT” to continue. If any of the terms of the license agreement are not acceptable, click “I DO NOT ACCEPT”. The database sharing facility will not function until the license agreement has been accepted.

The main user interface for publishing your PGDBs will differ, depending on how you answered the basic setup questions. There are three possible cases, each documented separately below. Please refer to the sec​tion that matches the setup of your site.

Case 1:
If you answered “Yes” to “use FTP for uploading”, and “yes” to “is it necessary to move uploaded files before they can be retrieved”.

In this case, the publishing process will have two steps: “package & upload” and “register”.

Step 1:
Package and upload.

The dialog shown in Figure XXX will appear on the screen. Select the corresponding checkbox for the databases that you intend to publish, and when you are satisfied with your choices, click the button labeled “Package and upload selected databases”. The packaging and uploading process will probably take several minutes, during which a series of messages will detail the steps being performed. When the process is complete, a “Done” message will appear in the message window.

Before continuing with the “Register” step, you must now move your packaged data​bases to their final location on your FTP server, from which they can be retrieved using anonymous FTP. If you are not sure how to do this at your site, please consult your local system administrator.

Step 2:
Register

As noted above, you must have moved your files to their proper locations for retrieval by outside users before performing this step. The dialog shown in Figure XXX will appear. Select the databases that you want to publish by left-clicking the correspond​ing checkbox in the column labeled “Select for publishing”. If you require users to execute a click-through license agreement for the database, select that checkbox as well.

Before completing the registration process, we strongly recommend that you click the “Refresh (check FTP server)” button. This command connects to the FTP server and directory that you have designated in the Database Sharing preferences dialog, and tries to obtain the file size (not the contents) of the archive file for each of the databases listed. If the file is missing, or for some reason Pathway Tools is unable to connect to the server, any error messages encountered are displayed in the message window, and the database is grayed out and will not be processed by the “Register” command. NOTE: When you click “Register”, the same check is done for each database to be registered, and process​ing of all databases will be stopped. Running the “Refresh” command allows you to fix any problems before you actually try to register your databases.

If you plan to use a click-through license for any of your databases, the “Test a click-through license” button prompts for a URL, then displays the contents of that URL just as it will be displayed to users who want to install your databases. This gives you a chance to fine-tune the content and presentation of your license agreement files, before they are presented to actual users.

When you are satisfied with your choices, click the “Register selected files” button. If you have specified that a license agreement will be required for any of your database, you will be prompted for the URL of the license agreement. Assuming that there are no problems with your FTP server, the registration process should complete very quickly.

Case 2:
“No” to “use FTP for uploading”.

In this case, Pathway Tools automates only the packaging of your databases, and all of the work of moving the archived databases to an FTP server is done outside of Pathway Tools.

The “Publish” command will display the dialog shown in Figure XXX. Click on the corre​sponding checkbox for the databases that you intend to publish. When you are satisfied with your choices, click the “Package selected databases” button, and the packaging process will begin. Packaging normally takes a few minutes to complete, during which time a series of mes​sages will keep you informed of the process’ progress.

When packaging has completed, a message will show the location of the files containing the packaged databases. Before running the “Register” step, you must move these files into the locations that you entered in the Database Sharing preferences dialog, from which they can be retrieved by users at other locations.

Once the files have been moved to your FTP server and are ready to be retrieved, the “Register” step is identical to that for Case 1, above. Follow the instructions for Step 2 above to complete the process of publishing your databases.

Case 3:
“Yes” to “use FTP for uploading”, “no” to “is it necessary to move uploaded files before they can be retrieved”.

In this case, the entire publishing operation can be accomplished with a single click. If you are one of these fortunate users, you will see the dialog shown in Figure XXX.

 Select the databases that you want to publish by left-clicking the corresponding checkbox in the column labeled "Select for publishing". If you require users to execute a click-through license agreement for the database, select that checkbox as well. When you are satisfied with your choices, click the "Publish selected databases" button.

 The process of packaging, storing, and registering your databases will take several minutes to complete. A sub-window at the bottom of the publishing dialog will display information about the various steps involved as they are performed.

 If no errors are encountered during the publishing process, a “Done” message will appear in the message window. Your databases will be available for immediate retrieval by other Pathway Tools users. The “Browse Downloadable PGDBs” command should show your databases along with those contributed by other users.

4.1.3    About click-through licenses
If desired, you can require users at other sites to execute what is commonly referred to as a “click-through” license, before they are allowed to retrieve and install your databases on their system. If the user clicks on “I DO NOT ACCEPT”, the database will not be retrieved from the FTP server on which it is stored.

In order to create a click-through license, you need to put the text of your license into a file, which can be accessed by means of a standard Web URL. Pathway Tools supports a limited set of HTML tags, to allow you to add boldface, italics, and a few other formatting options. Specifically, the “B”, “I”, “H1”, “H2”, “H3”, and “H4” tags are supported. Other HTML formatting, such as table directives, will be ignored. HTML formatting cannot be extended across line breaks: if you have boldface text that extends across multiple lines, you need to add <B> at the beginning of each line, and </B> at the end of each line. Lines separated by only a single new-line will be filled, to allow the text to fit neatly into the window that Path​way Tools puts up. Multiple new-lines separate paragraphs. Note that the filling process does not preserve word breaks across lines, so it is necessary to put a space at the beginning of each line in a paragraph. For an example of a file with this type of formatting, see the SRI click-through license at:

• 
http://bioinformatics.ai.sri.com/ptools/downloadable-database-license.html

If you view this file using the “View -> Source” command available in most Web browsers, you can see the formatting tags.

5

Troubleshooting

Pathway Tools detects the occurrence of an internal error. A dialog window pops up that contains an error message and asks you if you want to exit back to Unix, or to reset the software. You can select either choice with the mouse.

5.1
Frequently Asked Questions

A list of Pathway Tools Frequently Asked Questions is available on the SRI Web site at http:// www.ai.sri.com/pkarp/ptools/faq.html.

5.2
Reporting Problems

If you encounter problems with the software, or if you see errors in the scientific information in a data set, or if you have suggestions about the program, contact us by sending electronic mail to biocyc-sup​port@ai.sri.com.

When the Pathway Tools software detects an internal error, it writes a descriptive file called error.tmp in your home directory. That file helps SRI Technical Support track down the problem, so you will need to mail the file to biocyc-support@ai.sri.com. Mail the file only once for every distinct bug that you encounter; that is, if you repeatedly encounter what appears to be the same bug, tell us about it only once.

Include a description of the problem, and be as thorough as possible. Include the names of relevant data​base objects, or a description of the operations you had performed using Pathway Tools before an error occurred. Also tell us what version of Pathway Tools you are running. The version number appears in the title bar of the Navigator main window. More complete version information can be obtained by typing this command at the Unix command line: ptools -id.

A

Guide to the Pathway Tools Schema

All Pathway/Genome Databases (PGDBs) used by the Pathway Tools software -- including the EcoCyc and MetaCyc PGDBs -- must conform to the schema (ontology) described herein. The objects and the rela​tionships between these objects are utilized in this computerized description of metabolic and genomic information. Understanding the schema is essential for both users and developers of Pathway/Genome Databases who are using the Pathway Tools software.

In defining a conceptualization of knowledge for computer use, it is essential to employ precise definitions and distinctions. The fidelity of a computer representation determines the degree to which meaningful computations and analyses can be performed with the information in computer form. Unfortunately, many concepts in biology are not defined with the required precision. For example, a half dozen biologists could easily supply a half dozen conflicting definitions for the terms “gene,” or “metabolic pathway.” You may discover that our definitions of the class names and attribute names employed herein do not match the def​initions that you prefer. We ask you to acknowledge that (a) biology is not yet well enough formalized that every biologist can expect to employ the same definitions, and (b) the definitions used in this document are much more thorough and precise (and therefore useful) than those offered in most biological databases.

Much of the discussion in this document refers to the EcoCyc knowledge base (KB), but the same schema is used for all other KBs managed by Pathway Tools. This schema may change in future versions of the software.

PGDBs are stored within a frame knowledge representation system (FRS). An FRS is a kind of object-ori​ented database system. The KB consists of a collection of frames, where each frame encodes information about a single object, such as an enzyme, a gene, or a biochemical pathway. For a more precise discussion of FRSs, see [5].

Instance frames describe specific biological objects, such as a specific gene or a specific metabolic path​way. C;ass fra,es describe general types of biological objects, such as the class of all genes. Each frame contains one or more slots. A slot describes an attribute or a property of the object that the frame repre​sents. Each slot makes sense for (is valid in) a particular set of classes. For example, the slot EC-Number makes sense only for frames in the Reactions class, whereas the slot Synonyms is valid in all classes.

The current Pathway Tools ontology contains several hundred classes arranged in a taxonomic hierarchy. Figure    shows some of the major classes, and their relationships. An arrow that points from class A to class B indicates that A is a child of B, and therefore that A is a more general class that subsumes B. For example, the class Proteins can be subdivided into the subclasses Polypeptides (monomers) and Protein-Complexes (multimers). Subclasses inherit slots from their parents, for example, Polypeptides inherits all slots defined in Proteins, and some additional slots are also defined in Polypeptides. The classes in this figure whose names are shown in bold are described in more detail in the remainder of this appendix. 

The top-level classes in this figure describe physical entities and processes. More specifically, Chemi​cals describes atoms and complete chemical compounds, Polymer-Segments describes regions within polymers such as proteins and DNA, and Organisms describes the biological organism modeled within a PGDB. The class Chemicals is subdivided into small-molecular weight compounds (class Compounds) and atoms (not shown), and into macromolecules (Macromolecules). Macromole​cules includes subclasses such as DNA and RNA; DNA includes subclasses that describe different types of replicons such as chromosomes and plasmids. The different subclasses of Polymer-Segments include different types of DNA sites such as promoters and terminators, and longer regions such as genes. On the process side, Generalized-Reactions describes both individual biochemical reactions, and bio​chemical pathways. The class Enzymatic-Reactions describes information specific to the pairing of an enzyme with a reaction that the enzyme catalyzes, such as its activators, inhibitors, and cofactors.

.
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Figure A-1: Some of the main classes defined in the schemas of Pathway/Genome Databases. The arrows denote the special​ization–generalization relationship; for example, this figure indicates that all polypeptides are proteins, because class Pro​teins is the parent (generalization) of Polypeptides. A class inherits slots from its parents; therefore, the slots that are applicable to a given class are those slots inherited from its parent, plus those slots defined locally in that class.

The sections that follow describe the major classes and their slots in more detail. For additional discus​sions of the representations employed in the Pathway Tools ontology, see [10, 7].

A.1   Slots Valid in Multiple Classes

We begin with a discussion of slots that are used in several different EcoCyc classes.

This guide sometimes displays slot names capitalized, and sometimes in lowercase. In fact, all slot names are all uppercase in the KB itself. However, for the purpose of writing Lisp queries to Pathway/Genome Databases, all slot names can be written as lowercase in those queries, because the Lisp interpreter trans​lates all symbol names to uppercase (except for symbol names written between vertical bars). Hyphens separate multiple words in a slot name.

A.1.1   Common-Name

This slot defines the primary name by which an object is known to scientists — a widely used and familiar name (in some cases arbitrary choices must be made). This field can have only one value; that value must be a string.

A.1.2   Synonyms

This field defines one or more secondary names for an object — names that a scientist might attempt to use to retrieve the object. These names may be out of date or ambiguous, but are used to facilitate retrieval — the Synonyms should include any name that you might use to try to retrieve an object. In a sense, “Syn​onyms” is misleading because the names listed in this slot may not be exactly synonymous with the pre​ferred name of the object.

A.1.3   Names

Values of this slot are computed by combining the values of all other name-related slots for this frame: slots Common-Name, Systematic Name, Synonyms, N–Name, N–1–Name, and N+1–Name.

A.1.4   Comment

The Comment slot stores a general comment about the object that contains the slot. The comment should always be enclosed in double quotes. Section 5.5.4 of the Pathway Tools User’s Guide explains various special formatting conventions that can be used within the Comment slot for effects such as italics and citations.

A.1.5   Citations

This slot lists general citations pertaining to the object containing the slot. Each value of the slot is a cita​tion of the form [reference-ID], where reference-ID is a Medline unique identifier.

A.2   Class Binding Reactions

In a binding reaction, a set of reactants bind together to form a single product that is a complex of the reac​tants.

A.2.1   Reactants

The entities that are the reactants that bind together to form a complex.

A.2.2   Activators

This slot lists entities that activate the current binding reaction. To indicate an entity that is a complex of two other entities, use a list notation. For example, if a binding reaction involving RNA polymerase and a promoter is inhibited by a complex consisting of a DNA binding site and a protein, that complex could be indicated as (TRP-OP. TRP-REP) where TRP-OP is the identifier of an operator region, and TRP-REP is the identifier of a repressor protein.

A.2.3   Inhibitors

This slot lists entities that inhibit the current binding reaction. Use the same notation to indicate complexes as is used for the activators slot.

A.3   Class Compounds

The class Compounds describes small-molecular-weight chemical compounds — typically compounds that are substrates of metabolic reactions, or compounds that activate or inhibit metabolic enzymes.

A.3.1   Appears-In-Left-Side-Of, Appears-In-Right-Side-Of

Lists the one or more reactions in which this compound occurs as a reactant or product, respectively.

A.3.2   Aromatic-Rings

Each value in this slot is a list of atom numbers; that list of atoms constitutes a single aromatic ring. For example, the list might specify that atoms 1, 2, 5, 6, 10, 20 are in one aromatic ring (see slot Structure-Atoms).

A.3.3   Atom-Charges

This slot lists the charges of specific atoms within the compound. Each value of the slot is a list of the form (A C) where A is the index of an atom in slot Structure-Atoms, and C is the charge of that atom.

A.3.4   Charge

Lists the chemical charge for this compound.

A.3.5   Chemical-Formula

Lists the empirical formula for this compound. Each value of this slot is a list of the form (ATOM COUNT) where ATOM is the ID of a frame for the corresponding chemical element, and COUNT is the number of occurrences of that atom in this compound. For example, molecular oxygen, O2, would be rep​resented as (O 2) with a space in between the letter O and the number 2.

A.3.6   Display-Coords-2D

This slot lists coordinates for the display of the chemical structure of this compound in two dimensions. The values of this slot correspond one-to-one to the values of slot Structure-Atoms. Each value of this slot is a list of the form (X Y) and consists of the X-Y display coordinate of the corresponding atom in Struc​ture-Atoms. The coordinates are real numbers with no specified minimum or maximum values — they are re-scaled at display time.

A.3.7   Gibbs-0

Provides the standard Gibbs free energy of formation of the compound. The values are in units of kilocal​ories/mol, assuming the common state in aqueous solution at pH=7 and T=25C.

A.3.8   Molecular-Weight

Provides the molecular weight of this compound in Daltons.

A.3.9   N-Name, N-1-Name, N+1-Name

These slots are used when displaying the names of polymeric compounds in pathways that increase or decrease the lengths of the polymers. The names indicate a polymer of length N, length N-1, and length N+1. As an example, see the compound at http://biocyc.org:1555//META/NEW-IMAGE?type=COMPOUND&object=CPD-1301.

A.3.10   Smiles

Provides a representation of the chemical structure of this compound using the SMILES chemical encod​ing system. Note that the value of this slot is computed using an attached procedure; do not attempt to store a value into this slot.

A.3.11   Structure-Atoms

This slot is one of several that are used to encode the chemical structure of a compound. This slot lists all the distinct atoms in the compound, with multiple entries for atoms of the same element that occur more than once. For example, water could be described as the list (H H O). The atoms are listed in no special order. However, other slots refer to the atoms in the compound according to their position in this list; for example, the first hydrogen is atom 0, and the oxygen is atom 2.

A.3.12   Structure-Bonds

This slot describes the chemical bonds within a compound. Each bond is encoded as a list of the form (A1 A2 B-TYPE) where A1 is the index in slot Structure-Atoms of the first atom in the bond, A1 is the index of the second atom in the bond, and B-TYPE encodes the type of the chemical bond. Valid bond types are the numbers 1, 2, and 3 for single, double, and triple bounds, and the symbol :AROMATIC for aromatic bonds. For example, to specify that a double bond exists between the first and fifth atoms, use the list (0 4 2).

A.4   Class DNA-Binding-Sites

This class describes DNA regions that are binding sites for transcription factors.

A.4.1   Relative-Center-Distance

This slot defines the distance from the center of this binding site to another DNA region of interest.

A.5   Class Enzymatic Reactions

Frames in the class Enzymatic-Reactions describe attributes of an enzyme with respect to a particular reac​tion. For reactions that are catalyzed by more than one enzyme, or for enzymes that catalyze more than one reaction, multiple Enzymatic-Reactions frames are created — one for each enzyme/reaction pair. For example, Enzymatic-Reactions frames can represent the fact that two enzymes that catalyze the same reac​tion may be controlled by different activators and inhibitors. See [10] for more details.

A.5.1   Enzyme

This slot lists the enzyme whose activity is described in this frame. More specifically, the value of this slot is the key of a frame from the class Protein-Complex or Polypeptide.

A.5.2   Required-Protein-Complex

Some enzymes catalyze only a particular reaction when they are components of a larger protein complex. For such an enzyme, this slot identifies the particular protein complex of which the enzyme must be a component.

A.5.3   Reaction

The value of this slot is the key of a frame from the Reaction class — the second half of the enzyme/reac​tion pair that the current frame describes. In fact, this slot can have multiple values, which encode the mul​tiple reactions that one catalytic site of an enzyme catalyzes.

A.5.4   Activators, Inhibitors

This collection of slots lists inhibitor and activator compounds for this enzymatic reaction. Each com​pound is listed under the slot whose name best describes the mechanism of action of the compound, if known. For competitive activators or inhibitors, the competing compound is currently listed in a comment. The full list of activator and inhibitor slot names is 

ACTIVATORS-ALLOSTERIC 

ACTIVATORS-NONALLOSTERIC 

ACTIVATORS-UNKMECH 

INHIBITORS-COMPETITIVE 

INHIBITORS-NONCOMPETITIVE

INHIBITORS-UNCOMPETITIVE

INHIBITORS-ALLOSTERIC 

INHIBITORS-IRREVERSIBLE

INHIBITORS-NEITHER 

INHIBITORS-UNKMECH 

The fact that a compound is listed in this slot makes no commitment as to whether the effects of the com​pound on the enzyme are of physiological relevance, as opposed to whether the effects are known purely because of in vitro studies.

A.5.5   Physiologically-Relevant

This slot is a companion to the preceding slots for activators and inhibitors. It contains a list of those acti​vators and inhibitors whose effects are known to be of physiological relevance. That is, this slot indicates which of the compounds named in the preceding slots are physiologically relevant. The values of this slot are therefore a (possibly empty) subset of all values of the activators and inhibitors slots.

A.5.6   Cofactors, Prosthetic-Groups

The literature uses terms such as coenzyme, cofactor, and prosthetic group in an extremely inconsistent fashion. In version 2.8 of EcoCyc (March 1996) we adopted the usage of these terms that was developed by Eugeni Selkov (Gene Selkov) for use in the Enzymes and Metabolic Pathways (EMP) database. 

The section “Class Reactions” in section A.1398, defined the substrates of a reaction as the union of its reactants and its products. After Selkov, we define a coenzyme to be a specialization of substrates, namely, sub​strates with a relatively stable, conserved moiety, whose main function is group transfer among different enzymes and pathways. Example: NAD. EcoCyc does not define a special slot for coenzymes.

Also after Selkov, we define cofactors and prosthetic groups to be compounds that are required for an enzyme to catalyze a reaction, but that are unchanged by the reaction. Thus, cofactors and prosthetic groups are (loosely speaking) activators of an enzyme in the sense that the enzyme is not active when these compounds are absent. However, cofactors and prosthetic groups have an infinite “activation degree,” thus distinguishing them from those compounds that will be listed in the Activators slots (whose defini​tions were given earlier in this section); when Activators are missing, the enzyme still functions, but at a lower rate.

The distinction between cofactors and prosthetic groups is that prosthetic groups are covalently or tightly bound to an enzyme, whereas cofactors are not. The corresponding slot names are Cofactors and Prosthetic-Groups.

A slot called Cofactors-Or-Prosthetic-Groups identifies compounds whose binding affinity to the enzyme is unclear.

A.5.7   Alternative-Substrates, Alternative-Cofactors

These slots record variability in the substrates and cofactors that have been observed for this enzymatic reaction. If, for example, the literature indicates that Mn+2 can substitute for Mg+2 as a cofactor in this reaction, we would list the following as a value for the Alternative-Cofactors slot: (Mg+2 Mn+2).

The Alternative-Substrates slot describes the substrate specificity of an enzymatic reaction. We use the Alternative-Substrates when the complete equation is not known for an alternative reaction, or when the alternative reaction is not physiologically important, or is not a member of a known pathway. Each value of the Alternative-Substrates slot is a list whose first member is a compound that was specified as a substrate; the remaining elements of the list are compounds that can serve as alternative substrates for the first compound.

Each value of the Alternative-Cofactors slot is a list whose first member is a compound that was specified as a cofactor or prosthetic group; the remaining elements of the list are compounds that can serve as alternatives for the first compound.

An annotation on a value for either of these slots is assumed to apply to each alternative substrate/cofactor listed in the value. If an annotation is intended to apply to only one such compound (or other subset), two (or more) values should be used instead, where the substrate is repeated as the first element of each value, and the alternative compounds are divided among the values according to the applicability of the annota​tions.

A.5.8   Reaction-Direction

This slot specifies the directionality of a reaction. The slot is particularly important to fill for reactions that are not part of a pathway, because for such reactions, the direction cannot be determined automatically, whereas for reactions within a pathway, the direction can be inferred from the pathway context. This slot aids the user and software in inferring the direction in which the reaction typically occurs in physiological settings, relative to the direction in which the reaction is stored in the database. Possible values of this slot are 

• 
:REVERSIBLE: The reaction occurs in both directions in physiological settings. 

• 
:PHYSIOL-LEFT-TO-RIGHT, :PHYSIOL-RIGHT-TO-LEFT: The reaction occurs in the specified direction in physiological settings, because of several possible factors including the energetics of the reaction, local concentrations of reactants and products, and the regulation of the enzyme or its expression. 
• 
:IRREVERSIBLE-LEFT-TO-RIGHT, :IRREVERSIBLE-RIGHT-TO-LEFT: For all practi​cal purposes, the reaction occurs only in the specified direction in physiological settings, because of chemical properties of the reaction.

A.6   Class Genes

Each frame in the class Genes describes a single gene, meaning a region of DNA that defines a coding region for one or more gene products. Multiple gene products may be produced due to modification of an RNA or protein.

A.6.1   Left-End-Position, Right-End-Position

These slots encode the position of the left and right ends of the gene on the chromosome or plasmid on which the gene resides. “Left” means the end of the gene toward the coordinate-system origin (0). There​fore, the Left-End-Position is always less than the Right-End-Position.

In the EcoCyc DB, the values of this slot were taken directly from Genbank entry U00096 submitted by the Blattner laboratory.

A.6.2   Centisome-Position

This slot lists the map position of this gene on the chromosome in centisome units (percentage length of the chromosome). The centisome-position values are computed automatically by Pathway Tools from the Left-End-Position slot. The value is a number between 0 and 100, inclusive.

A.6.3   Transcription-Direction

This slot specifies the direction along the chromosome in which this gene is transcribed; allowable values are “+” and “-”. 

A.6.4   Product

This slot holds the ID of a polypeptide or tRNA frame, which is the product of this gene. This slot may contain multiple values for two possible reasons: a given gene might be translated from more than one start codon, giving rise to products of different lengths; the product of the gene may undergo chemical modifi​cation. In the latter case, the gene lists all modified forms of the protein in its Product slot.

A.6.5   Evidence

Describes evidence for the defined function of this gene. Currently, we distinguish between function that is determined experimentally (value :Experiment), and function that is determined through computational sequence analysis (value :Sequence-Analysis).

A.6.6   Interrupted?

If True, indicates that the specified gene is interrupted, that is, has a premature stop codon.

A.7   Class Organisms

Each PGDB contains a single frame that is an instance of class Organisms, and whose unique ID is the same as the unique ID that was assigned to the PGDB itself when the PGDB was created. For example, the BsubCyc PGDB contains a frame whose unique ID is BSUB. This frame encodes information about the organism described by the PGDB, and encodes information about the PGDB itself. Much of the latter information is displayed by the Pathway/Genome Navigator, such as in the organism summary page for the organism.

A.7.1   PGDB-Authors

A list of the names of the authors of this KB. The names are displayed on a summary page for this organ​ism. It is appropriate to suffix each name with the author's institution, for example, "John Doe, University of New Jersey". Use one slot value per author.

A.7.2   PGDB-Copyright

The contents of this slot should be a copyright notice for this database, if one is desired. The copyright notice should preferably fit in one line because it will be printed at the bottom of every Web page served for this organism database by the Pathway Tools Web server. Example: “Copyright 1999 University of New Jersey.”

A.7.3   PGDB-Footer-Citation

The value of this slot should be a single literature citation, in the form of a string, such as "Bioinformatics 12:155 2002". This citation, if present, is printed at the bottom of each Web page served for this organism, within the following text:   “Please cite XXXCyc as CITATION in publications resulting from its use.”

A.7.4   PGDB-Home-Page

The URL of a Web page describing this PGDB. Authors can use this page to provide more background information about the PGDB.

A.7.5   PGDB-Name

The name of the database for this organism, when the database name is to be printed somewhere by Path​way Tools. Examples: “EcoCyc,” “PlasmoCyc.” The suffix “Cyc” is not required.

A.7.6   PGDB-Unique-ID

An integer unique ID for this PGDB that differentiates it from other PGDBs. This ID is used to build unique IDs for newly created frames that are created in this PGDB so that (a) when frames are copied among PGDBs, we know what PGDB the frame originated in, and (b) we can ensure that two frames in two different PGDBs that have the same ID do in fact refer to the same biological entity. The MetaCyc KB has a PGDB-Unique-ID of NIL; all other KBs should have a non-NIL value for this slot.

A.7.7   Strain-Name

Specifies the strain name for the organism. 

A.7.8   Taxonomic-Domain

The taxonomic domain to which this organism belongs. Possible values are :EUBACTERIA, :EUKARY​OTES, :ARCHAEA, :VIRUSES.

A.7.9   Contact-Email

The email address of a person who serves at the primary contact for this PGDB, such as to receive ques​tions or bug reports from users of the PGDB.

A.7.10   Genome

A list of all replicons (chromosomes and plasmids) in the genome of the organism.

A.8   Class Pathways

Frames in class Pathways encode metabolic and signaling pathways.

A.8.1   Net-Reaction-Equation

This slot specifies the net chemical transformation accomplished by a pathway, including the stoichiome​try, and is written in the same form as the Reaction Equation slot.

A.8.2   Pathway-Interactions

This slot holds a comment that describes interactions between this pathway and other biochemical path​ways, such as those pathways that supply an important precursor.

A.8.3   Predecessors

This slot describes the linked reactions that compose the current pathway. Since pathways have a variety of topologies — from linear to circular to tree structured — pathways cannot be represented as simple sequences of reactions. A pathway is a list of reaction/predecessor pairs. That is, each value of this slot is of the form (reaction-ID pred-ID*) where reaction-ID is the key of a reaction in the pathway, and each pred-ID is the key of a reaction in the pathway that directly precedes the reaction-ID reaction. For exam​ple, to represent the combined pathway for tyrosine and phenylalanine synthesis (see Figure   ), this pre​decessor list might be used: 

     predecessors: (chorismatemut-rxn), 

                   (prephenatedehydrat-rxn chorismatemut-rxn), 

                   (pheaminotrans-rxn prephenatedehydrat-rxn), 

                   (prephenatedehydrog-rxn chorismatemut-rxn) 

                   (tyraminotrans-rxn prephenatedehydrog-rxn) 

[image: image19.wmf]
Figure A-2: This pathway shows the combined synthesis of the amino acids tyrosine and phenylalanine from chorismate. Each reaction is labeled by its key in the EcoCyc KB. For example, the key for the reaction that converts prephenate to phe​nylpyruvate is prephenatedehydrat-rxn. 

The first reaction in the pathway has no predecessor, so there is only one key within the first value. Since prephenate is a branch point in the pathway, two reactions in the pathway list the reaction that synthesizes prephenate as a predecessor.

Alternatively, any value for this slot can be another pathway key, which means that the current pathway inherits all the predecessor values of the indicated pathway. In other words, the current pathway is a super​pathway of the indicated pathway. Thus, a more compact way of representing the combined pathway for tyrosine and phenylalanine synthesis would be to use the following predecessor list: 

     predecessors: tyrsyn, phesyn 

In actuality, this latter representation is the preferred one and is required in order for the combined path​way to be determined to be a superpathway of either the tyrosine or phenylalanine (which of course should be the case). The advantage of specifying the predecessor list in this way (aside from being more compact 

and easy to read) is that if the subpathway is ever modified, the changes will automatically propagate to the superpathway.

A.8.4   Reaction-List

This slot lists all reactions in the current pathway, in no particular order. It is computed from the predeces​sors slot.

A.8.5   Hypothetical-Reactions

A list of reactions in this pathway that are considered hypothetical, probably because presence of the enzyme has not been demonstrated.

A.8.6   Assume-Unique-Enzymes

By default it is assumed that all enzymes that can catalyze a reaction will do so in each pathway in which the reaction occurs. That default assumption is encoded by the default value of FALSE for this slot; when you want to assume that only one enzyme exists in the KB to catalyze every reaction in this pathway, this slot should be given the value TRUE.

This slot can be used for consistency-checking purposes, that is, in a pathway for which this slot is TRUE, there should not exist any reactions that are catalyzed by more than one reaction.

A.8.7   Enzyme-Use

By default it is assumed that all enzymes that can catalyze a reaction will do so in each pathway in which the reaction occurs. This slot is used in the case that this assumption does not hold, that is, if a reaction is catalyzed in a particular pathway by only a subset (or none) of the possible enzymes that are known to cat​alyze that reaction. Therefore, this slot can be used only when the value of the assume-unique-enzymes slot is FALSE (because multiple enzymes catalyze some step in the pathway).

The form of a value for the slot is (reaction-ID enzymatic-reaction-ID-1... enzy​matic-reaction-ID-n). That is, each value specifies a reaction, and specifies the one or more enzy​matic reactions that catalyze that reaction in this pathway. If no enzymatic reactions are specified, then none of the enzymes that are known to catalyze the reaction do so in this pathway.

For example, under aerobic conditions the oxidation of succinate to fumarate is catalyzed by succinate dehydrogenase in the forward direction, and, under anaerobic conditions, by fumarate reductase in the reverse direction. The TCA cycle is active only in aerobic conditions, so only succinate dehydrogenase is used in this pathway. This fact would be recorded as follows: 

     enzyme-use: (succ-fum-oxred-rxn succinate-oxn-enzrxn) 

A.8.8   Primaries

When drawing a pathway, the Navigator software usually computes automatically which compounds are primaries (mains) and which compounds are secondaries (sides). Occasionally, the heuristics used are not sufficient to make the correct distinction, in which case you can specify primary compounds explicitly. This slot can contain the list of primary reactants, primary products, or both for a particular reaction in the pathway. Each value for this slot is of the form (reaction-ID (primary-reactant-ID-1 ... primary-reactant-ID-n) (primary-product-ID-1 ... primary-product-ID-n)), where an empty list in either the reactant or product position means that that information is not sup​plied and should be computed.

For example, in the purine synthesis pathway, we want to specify that the primary product for the final reaction in the pathway should be AMP and not fumarate. The primary reactants are still computed. The corresponding slot value would be 

        primaries: (ampsyn-rxn () (amp)) 

A.8.9   Species

This slot is used in pathway frames in only the MetaCyc DB, in which case the slot identifies the one or more species in which this pathway is known to occur experimentally.

A.8.10   Disable Display

When the value is true, this slot disables display of the pathway drawing for a pathway.

A.8.11   Super-Pathways

This slot lists direct super-pathways of a pathway. Its value is computed by the Pathway Tools consis​tency-checking code by comparing the predecessors slots of each pathway in the KB, and therefore should not be set by the user. A pathway key does not have to be explicitly specified in a predecessor slot in order for the superpathway relationship to be detected.

A.8.12   Sub-Pathways

This slot is the inverse of the Super-Pathways slot. It lists all the direct subpathways of a pathway. The val​ues of this slot are computed automatically; see slot Super-Pathways.

A.8.13   Pathway-Links

This slot indicates linkages among pathways in pathway drawings. Each value of this slot is a list of the form (cpd other-pwy*). The Navigator draws an arrow from the specified compound pointing to the names of the specified pathways, to note that the compound is also a substrate in those other pathways. If no other pathways are specified, then links are drawn to and from all other pathways that the compound is in (i.e., if the compound is produced by the current pathway, then links are drawn to all other pathways that consume it, and vice versa).

A.8.14   Polymerization-Links

This slot controls drawing of polymerization relationships within a pathway. Each value of this slot is of the form (cpd-class product-rxn reactant-rxn). When both reactions are non-nil, an iden​tity link is created between the polymer compound class cpd-class, a product of product-rxn, and the same compound class as a reactant of reactant-rxn. The PRODUCT-NAME-SLOT and REACTANT-NAME-SLOT annotations specify which slot should be used to derive the compound label in product-rxn and reac​tant-rxn above, respectively — if one or both are omitted, COMMON-NAME is assumed. Either reaction above may be nil; in this case, no identity link is created — this form is used solely in conjunction with one of the name-slot annotations to specify a name-slot other than COMMON-NAME for a polymer compound class in a reaction of the pathway.

A.8.15   Class-Instance-Links

Each value of this slot is a reaction in the pathway. Two annotations (in addition to the usual possibilities) are available on this slot: REACTANT-INSTANCES and PRODUCT-INSTANCES, whose values are compounds. If one of the reactants of the slot-value reaction is a class C and the REACTANT-INSTANCES are instances of C, then the instances are drawn as part of the pathway, with identity links to the class. The PRODUCT-INSTANCES are treated similarly.

A.8.16   Layout-Advice

Each value of this slot is a dotted pair of the form (advice-keyword . advice, and represents some piece of advice to the automatic pathway layout code. Currently supported advice keywords are

• 
:CYCLE-TOP-CPD: The advice is a compound key. In pathways containing a cycle, the cycle will be rotated so that the specified compound is positioned at twelve o’clock.

• 
:REVERSIBLE-RXNS: The advice is a list of reactions that should be drawn as reversible, even when the pathway is being drawn to show pathway flow (rather than true reversibility). 

• 
:CASCADE-RXN-ORDERING -- The advice is a list of reactions that form a partial order for reactions in a cascade pathway (i.e. the 2-component signalling pathways). 

A.9   Class Polypeptides

Frames of class Polypeptides are monomers consisting of a single polypeptide chain.

A.9.1   Gene

This slot contains a value that identifies the gene that encodes the polypeptide.

When a polypeptide exists in two forms, modified and unmodified, both forms contain the same value in their Gene slots.

A.9.2   Features

This slot links the polypeptide to any protein features that have been defined for it. When a polypeptide exists in multiple forms, each form will link to the same set of features.

A.9.3   Splice-Form-Introns

This slot lists any introns that were spliced out of the gene in order to generate this polypeptide. Values of this slot are of the form (start-bp end-bp).

A.10   Class Promoters

Frames in this class define promoters.

A.10.1   Absolute-Plus-1-Pos

The absolute base pair position of the promoter on the DNA strand.

A.11   Class Protein-Complexes

Frames of class Protein-Complexes are multimeric proteins composed of multiple subunits. The subunits of a protein complex may themselves be protein complexes, although eventually the subunits must bottom out as polypeptides.

A.11.1   Components

This slot lists the subunits of a protein complex. Each subunit is either a polypeptide or a protein complex; therefore, each slot value is the key of a polypeptide frame or a protein-complex frame.

The coefficient of each component of the protein complex is listed as an annotation of the component value under the label Coefficient [5].

A.12   Class Proteins

The class of all proteins is divided into two subclasses: protein complexes and polypeptides. A polypeptide is a single amino acid chain produced from a single gene. A protein complex is a multimeric aggregation of more than one polypeptide subunit. A protein complex may in some cases have another protein complex as a component.

A.12.1   Component–Of

This slot lists the protein complex(es) that this protein is a component of, if any. Protein complexes may contain other protein complexes as components.

A.12.2   DNA-Footprint-Size

For proteins that bind to DNA, the number of base pairs on the DNA strand that the binding protein covers.

A.12.3   Locations

This slot describes the one or more cellular locations in which this protein is found, one of

• 
:Cytoplasm: Protein is floating in the cytoplasm

• 
:Membrane: Associated with either the inner or the outer membrane

• 
:Inner-Membrane: Somehow associated with, or a component of, the inner membrane

• 
:Outer-Membrane: Somehow associated with, or a component of, the outer membrane

• 
:Periplasm: Space between the inner and outer membrane

• 
:Extracellular: Protein is secreted to the external environment of the cell 

A.12.4   Modified-Form

This slot points from the unmodified form of a protein, to one or more chemically modified forms of that protein. For example, the slot might point from the unmodified form of a polypeptide (or a protein com​plex) to a phosphorylated form of that polypeptide (or protein complex).

A.12.5   Molecular-Weight-KD

This computed slot lists the known molecular weight(s) of a macromolecule in kilodaltons by taking the union of the slots Molecular-Weight-Seq and Molecular-Weight-Exp.

A.12.6   Molecular-Weight-Seq

This slot lists the molecular weight of the protein complex or polypeptide, as derived from sequence data. Units: kilodaltons.

A.12.7   Molecular-Weight-Exp

This slot lists the molecular weight of the protein complex or polypeptide, derived experimentally. Multi​ple values of this slot correspond to multiple experimental observations. Units: kilodaltons.

A.12.8   Neidhardt-Spot-Number

This slot lists the Neidhardt-Spot-Number of the protein, reflecting its electrophoretic behavior in two-dimensional electrophoresis [15].

A.12.9   pI

This slot lists the pI of the polypeptide.

A.12.10   Species

This slot is used in proteins only in the MetaCyc DB, in which case it identifies the species in which the current protein is found.

A.12.11   Unmodified-Form

This slots points from a chemically modified form of some protein, to the native unmodified form of that protein (e.g., from a phosphorylated form to the unphosphorylated form).

A.13   Class Reactions

Frames within the Reaction class describe properties of a biochemical reaction independent of any enzyme or enzymes that catalyze that reaction. A reaction is a biochemical transformation that interconverts two sets of chemical compounds (which includes small metabolites, proteins, and DNA regions), and may translocate compounds from one cellular compartment to another. Most reactions are written in a conven​tional direction that has been assigned by the Enzyme Nomenclature Commission, but that direction may or may not be the predominate physiological direction of the reaction. Reaction substrates can include small-molecular-weight compounds (for metabolic reactions), proteins (such as in signaling pathways), and DNA sites (such as for reactions involving binding of transcription factors to DNA).

Two novel features of our conceptualization with respect to previous metabolic databases are to separate reactions from the enzymes that catalyze them, and to use the EC numbers defined by the International Union of Biochemistry and Molecular Biology (IUBMB) to uniquely identify reactions, not enzymes. (In database terms, the EC number is a key for the Reaction class.) The reason for this separation is that the catalyzes relationship between reactions and enzymes is many-to-many: a given enzyme might catalyze more than one reaction, and the same reaction might be catalyzed by more than one enzyme. Frames in the class Enzymatic-Reaction describe the association between an enzyme and a reaction.

You should always write transport reactions in the predominate direction in which the reaction occurs. Transport reactions are encoded by labeling substrates with their cellular compartment. For example, if a given substrate is transported from the periplasm to the cytoplasm, it would be labeled with “periplasm” as its compartment as a reactant, and with “cytoplasm” as its compartment as a product. The default compart​ment is the cytoplasm, so the cytoplasm label may be omitted. These labels are implemented as annota​tions in Ocelot.

A.13.1   EC-Number

This slot holds the EC (Enzyme Commission) number associated with the current reaction, if such a num​ber has been assigned by the IUBMB. This slot is single valued.

A.13.2   Official-EC?

The value of this slot is NO if the current reaction either was not defined at all by the Enzyme Commis​sion, or if the current equation stored for that reaction is not the equation assigned by the EC (e.g., we have corrected the EC equation). Otherwise, the value is YES, which is the default inherited value.

A.13.3   Left, Right

These slots hold the compounds from the left and right sides, respectively, of the reaction equation. Each value is either the key of a compound frame, or a string that names a compound (when the compound is not yet described within the KB as a frame). The terms reactant and product are not used because these terms may falsely imply the physiological direction of the reaction.

The coefficient of each substrate, when that coefficient is not equal to 1, is stored as an annotation on the substrate value. The annotation label is COEFFICIENT.

The substrates of transport reactions are also described using the Left and Right slots. However, the values of these slots are annotated to indicate their compartments. For example, a transporter that moves succinate from the periplasm to the cytoplasm, accompanied by hydrolysis of ATP in the cytoplasm, would be described with succinate and ATP as the values of the Left slot, and with succinate, ADP, and Pi as the values of the Right slot. The succinate in the Left slot would be annotated with Periplasm under the label Compartment. The other substrates need not be annotated with a compart​ment because the default compartment is taken to be the cytoplasm.

A.13.4   Substrates

The value of this slot is computed automatically — its values may not be changed by the user. The values of the slot are computed as the union of the values of the Left and Right slots.

A.13.5   DeltaG0

This slot contains the change in Gibbs free energy for the reaction in the direction the reaction is written.

A.13.6   Spontaneous?

This slot is true in the case when this reaction occurs spontaneously, that is, it is not catalyzed by any enzyme.

A.13.7   Species

This slot is used to indicate that a reaction is known to occur in an organism in the case where the enzyme that catalyzes the reaction is unknown. In such cases, the value for this slot in a given reaction would be the symbolic identifier of the species for the organism for the current PGDB.

A.14   Class Transcription-Units

Frames in this class encode transcription units, which are defined as a set of genes and associated control regions that produce a single transcript. Thus, there is a one-to-one correspondence between promoters and transcription units. If a set of genes is controlled by multiple promoters, then a PGDB should define multi​ple transcription-unit frames, one for each promoter.

A.14.1   Components

The Components slot of a transcription unit lists, in 5’ to 3’ order, the DNA segments within the tran​scription unit, including promoters, DNA binding sites, and genes.

A.14.2   Extent-Unknown?

The value of this slot should be True when it is not known to how many genes the transcription unit extends; that is, it is not known which is the last gene in the transcription unit.

A.15   Class tRNAs

Frames of this class encode both charged and uncharged tRNAs.

A.15.1   Anticodon

This slot contains a string as a single value, which lists the three letters that make up the anticodon bases on the tRNA. The direction in which the letters are listed is 5’ to 3’ with respect to the tRNA. This is the reverse of, and complementary to, the sequence of the recognized codons.

A.15.2   Codons

This slot contains possibly multiple values as strings, which list the three letters that make up the base trip​lets recognized by the anticodon on the tRNA. The direction in which the letters are listed is 5’ to 3’ with respect to the coding strand of genes.
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